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This manual details the installation and use of the addVANTAGE Pro software
product, which is used in conjunction with most of Adcon’s telemetry devices.
For information about the installation and use of the telemetry devices, refer to
the respective device’s manual.

Following are some of the features in this version:

Enhanced right-click menu in Explorer and List view to improve usability.
Graph view, Table view, Event list, Virtual instruments, and Map view are
merged into one panel called Data view.

It is possible to show/hide the Graph view, where you can select the event
that is currently displayed. It can help to save space.

Improved skipping to last value when selecting another time span.

Data view now has a min/max start/end date; you cannot see data outside
this interval.

The newly integrated JavaScript engine (instead of former hostside
rendering of PNGs) gives a faster response and opens the door to new
features. New features can be added and modified easily.

With addVANTAGE Pro 6.6 it is much easier to edit data in the Graph view
(for example, min/max value and its position on the plot) and to change/
adjust the views and its illustration.

The algorithm used for stacking the Y-Axis on the plot has been improved.
Added time selection to quickly see how much data there is and what part
of it you are currently viewing. Also can be used to navigate and change the
selected time duration.

Added (semi-)transparent color selection for a trend line in Data view.

The addVANTAGE Pro software and telemetry devices work together to form the
Adcon system, which can be defined as a system that allows you to:

1.
2.

3.

Measure certain parameters over a predefined area.

Send those parameters over relatively large distances to a central point.
Process the parameters as needed for various applications such as
agriculture, meteorology, irrigation control, water management, and
environmental analysis.
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Note:

What is the Adcon System?

illustrates the components of the Adcon system.
Figure 1. The Adcon Telemetry System
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The electrically converted parameters are first stored in the memory of a
Remote Transmission Unit (RTU) (or transmitter). Adcon currently provides a
large array of RTUs employing different wireless technologies, from radio
module (UHF) to 3G/4G based devices.

An RTU has its own intelligence in the form of a built-in microcontroller, which
periodically performs several tasks, for example, interrogate the sensors, store
the measured data, check the radio channel, check the local battery status, and
so forth. It is part of a remote station, which consists of the RTU, its assembly
parts, and its sensors. The RTU is equipped with a radio module or a 3G/4G
modem, which allows for real-time wireless communication with a base station.

Reverse communication is also possible with the Adcon system. The
addVANTAGE Pro software can issue a command that will be sent via the
wireless network to the RTUs to control devices such as switches, pumps,
motors, and relays.

The base station consists of a Telemetry Gateway (or receiver), your personal
computer (and/or server) and a wireless modem. The addVANTAGE Pro software
runs as server installation and provides a web front-end. You can access the
data with your PC, laptop, tablet, smartphone—via an local area network or
Internet.

The Gateway acts as a network controller—at regular intervals (typically

15 minutes, but this can be changed) it requests data via radio from the UHF
RTUs or via 3G/4G modem from the GPRS RTUs in the network. The gateway
stores the incoming data in its memory, thus allowing the gateway to supervise
a large number of RTUs and keep their data for a period of time without the
need to download the data to the PC. The number of controlled RTUs depends on
the gateway type, and some receiver models can handle up to 1000 stations.

The period of time a gateway can store data depends on the number of RTUs in
the network, the customized settings and the gateway type. The oldest data is
overwritten.

The gateway is designed for the highest level of availability to ensure continuous
operation, even during power failure. The addVANTAGE Pro software regularly
downloads the data from the gateway’s memory to the PC.
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What is the Adcon System?

The addVANTAGE Pro software, which is based on a client/server architecture,
collects data from one or several Adcon Telemetry Gateways and makes it
available for viewing or for specialized analysis.

The server is that part of the software where all the actual processing takes
place. Depending on your settings it starts automatically when the computer is
started and runs in the background. The server is responsible for downloading
data from the Telemetry Gateway, storing data into the database, starting and
stopping extensions, and servicing clients as they connect.

The addVANTAGE Pro server is based on a modular concept, meaning its parts
contribute to the whole but are also independent of it. The server has a
framework that runs various services and each service is responsible for a
function. For example:

o The Security service authenticates the users and checks their privileges.
e The Directory service deals with all objects existing on the system.
o The Data Acquisition service retrieves the remote data.

o The Extension service creates the proper environment for the extensions to
run.

. The Database service assures the connection to the database for all other
services.

This modular approach provides a great degree of flexibility both to users and
programmers because it offers, among other things, an open interface for third
parties that want to program new extensions.

Starting with addVANTAGE Pro 5.0, the client software is based on a standard
web browser. Internet Explorer 11.0 and Mozilla Firefox have been certified to be
fully compatible with addVANTAGE Pro. Additional browsers could be supported
in future releases.

This Manual does not attempt to explain basic computer use. Therefore, you
should be familiar with basic computer terminology and the use of typical
computer interfaces.

Most operations in addVANTAGE Pro can be performed on a context basis. That
is, right-clicking an object displays a Context menu from which you select the
desired operation. You can see an example of a Context menu in
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illustrates the various items on a software window of addVANTAGE Pro.
Figure 2. A Typical Software Window
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(1) Listbox This area shows a list of choices you can select by clicking.

(2] Tab Click to see another view of the dialog.

(3) Checkbox Select or unselect by clicking the box. A selected box has
an X or a check mark in it, while an unselected box is
empty.

(4] Text field Type information here.

(5] Button These are rectangular shapes with a name or icon. Select a
button by clicking it.

0 Radio button These round buttons come in multiples. You can select only
one.

(7] Drop-down A box with a small down arrow you must click before you

can see the list of choices to select from.

This User Manual is an essential part of the product. Keep it in a safe place
during the product's entire life.

Read the User Manual carefully before use and follow the instructions, safety
messages and warnings to ensure a flawless operation of the product.

The product is designed to suit the purpose of the application described in this
User Manual. Applying the product outside the described purpose of application
will result in the termination of warranty obligation.

This User Manual describes the features available to users assigned to the
extension_user role, which includes the average_user role. You will not see
features reserved for any of the administrative roles.

This User Manual is intended for crop consultants, agricultural organizations and
agriculturalists, who work with measurement data.
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Certain terminology and abbreviations apply in this manual.

RTU Remote Transmission Unit (RTU)

Tags You'll see the terms tag and sensor used
throughout this manual. Tag is a generic term for
something that pertains to data, regardless of
whether it collects or controls that data. Tags can
represent any of the following:

Physical sensors, such as those for temperature,
leaf wetness, or humidity.

Actuators, such as switches, relays, or valves.

Virtual sensors, which are the result of a
computation, such as an average, a sum, or an
ETy (evapo-transpiration reading). Virtual sensors
are created with extensions. With some
extensions, you can use a virtual sensor in
combination with other sensors to create a new
virtual sensor, which in itself is another tag.

Parameters We mean a physical value that can be converted to
an electrical counterpart. For example, air
temperature, relative humidity, and leaf wetness
have values that can be converted to an electrical
form by means of sensors. If a sensor exists for a
certain physical parameter, it is very likely that it
can be adapted to Adcon s system.

Extensions Extensions are a very important concept of
addVANTAGE Pro. They are standalone modules
dealing with raw data and processing it according
to certain rules. Extensions provide events and
alarms; in some cases, extensions may provide
output tags (which are also called virtual sensors).

Certain conventions apply in this manual.

Italics Indicates the text is variable and must be
substituted for something specific, as indicated in
the explanation. Italics can also be used to
emphasize words as words or letters as letters,
and for cross references to other books.

Bold Indicates special emphasis of the text.

fixed font Indicates characters you must type or system
messages, as well as default values and file
names.

Help » About Indicates menu selection. For example, select the

Help menu, then the About option. Also indicates
items on the graphical user interface.

Note Indicates information of interest. Notes appear
after the information they apply to.
CAUTION Indicates that you might get unexpected results if

you don't follow the instructions. Cautions appear
before the information they apply to.

WARNING Indicates danger to yourself or damage to the
device if you don't follow the instructions.
Warnings appear before the information they
apply to.
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Adcon’s Data Acquisition system contains hardware and software parts.
The hardware components are:

e A personal computer and/or a server machine

o Complete base station to manage large networks of UHF and 3G/4G:
Telemetry Gateway (A850) and wireless modem (A440)

o Remote Transmission Units (RTU) (also referred to as devices), for example
addWAVE A753 (UHF or 3G/4G), addRELAY UHF Repeater Station (A751),
addIT A723

o Sensors and actuators

e  Various supplementary parts (accessories such as antennas, cables, and
masts)

The software consists of:

o The addVANTAGE Pro server

o Application-specific server extensions

o Utilities for configuration and maintenance
o A web browser



Note:

Since the initial introduction of addVANTAGE Pro 5 in 2006, you have been able
to access the client software through a standard internet browser such as
Microsoft Internet Explorer or Mozilla Firefox. While you still have the option to
install addVANTAGE Pro on your own server, you can also work through an
internet connection linking up to your data provider's addVANTAGE Pro 6.6
server, accessing all the features through your web browser on that machine. All
you will need is a fast internet connection and a user name and password to
access your data.

For optimal performance, especially in large networks, Adcon recommends that
you install the server on a dedicated machine. The server must have enough
power and memory, to sustain the expected number of clients and RTUs, as well
as the number of extensions that will process the data.

The server machine should be configured for growing networks.

You can consider several types of systems depending on your application and
the corresponding license type you acquired. For example, if you have an
application where you manage only one or two remote stations (RTUs), you
could install the server on the same machine you are using for your day-to-day
use. After installing addVANTAGE Pro you need only point your browser to your
local computer (e.g., http://localhost:8080) and you can analyze your data. You
don’t even need access to the Internet for this type of setup.

At the other end of options, if you intend to offer addVANTAGE Pro services to
other users, running tens or hundreds of RTUs, you most likely will want to
install the software on a powerful server with a good connection to the Internet.
A fixed IP address is mandatory in this case. In many cases you might not want
to run a server at all and would rather use the addVANTAGE Pro services offered
by an addVANTAGE Pro service provider. You need only a web browser, an
internet connection, and an account (possibly subscription-based) with your
addVANTAGE Pro provider.
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Connecting to addVANTAGE Pro |

Connecting to addVANTAGE Pro

Note:

You connect to addVANTAGE Pro by starting your browser and entering the URL
of your server, for example, http://demo.adcon.at:8080. A welcome page
similar to the one in Figure 3 is displayed in your browser.

Figure 3. addVANTAGE Pro Welcome Page

addVANTAGE Pro 6.6

The next level of visualisation

User Name: [T
Password: XX

M Go to IiVEdata@ﬁ

TELEMETRY Smart Wireless Solutions

If you need browser information for logging in, you can click the question mark
on the welcome page. A page with login help is displayed.

For the flawless use of addVANTAGE Pro you should deactivate the popup-
blocker in your browser!

You can also see the documentation before you log in, or get a preview of the
new features. Click the User Manual or New Features icon as needed.

Enter your User Name and Password and click the Login button to access the
system.

If the account data was correct, you are logged in to addVANTAGE Pro and an
Explorer window showing you the root node appears. If you want to disconnect
from the server, click the Logout button in the Tool bar (see "Menu Bar and Tool
Bar” on page 19.)

Navigating the Data

The Explorer

The main elements of the software are:

. The Explorer ("The Explorer” on page 13)
. The List (see "The List” on page 35)
. The Data view (see "The Data View Panel” on page 38)

After you have logged in, the browser will display the main window of
addVANTAGE Pro. This is called the Explorer because it allows you to explore all
the objects in an addVANTAGE Pro system.

Objects in the Explorer

Use the Explorer to navigate through all the objects in your system: areas, RTUs
(devices), tags (sensors), extensions, and panels. All such objects are
generically called nodes. You can open more than one Explorer at once, each
showing different levels of the system tree. You can also move certain node
types from one area to another.

After opening an Explorer, expand the root node, which will show areas, RTUs,
and tags. In order to familiarize you with the new terms, Figure 4 shows most of
the node types available in the tree structure. You probably won’t have all of
them in your tree, but you will be able to generate them.
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The root node contains all the objects in a system. You can also think of it as the

CHAPTER 2
Navigating the Data |

container for the database on a server.

Figure 4. Expansion of Root Node in Explorer
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Overview of Nodes

(1) Root node All the objects in your system (e.g. areas, RTUs, tags,
extensions, and panels) are called nodes. Start here to
explore your network.

(2] Area An area is an object that defines a certain place that you
have associated with a specific setting. It can be a field, a
city, a section in a plant, a country, or any other physical
place. You can also have areas within areas, or sueas.

(3) RTU An RTU is placed in an area. You can have as many RTUs in
an area as you want—limited only by the type of license
you own and the remote servers or Telemetry Gateways
you are downloading data from. All the RTUs in a certain
area have the common setting that they belong to that
area.

(4] Tags The RTUs have tags, which can be sensors or actuators. A
tag can also result out of the processing of other tags by an
extension.

(5) Crops Crops act as containers for extensions (calculations or
disease models) that are specific to one crop field in one
year. Crop nodes have all the required phenological phases,
irrigations, and treatments.

0 Disease models Disease models are types of embedded software that track
the progress of common diseases that are specific to a
crop. They are always the children of a crop node.

(7] Calculation Calculation extensions are types of embedded software

extensions that process input tags following certain rules and output
events or other tags (virtual tags). This type of extension
can also control output tags (actuators), effectively
implementing remote control functions. Calculation
extensions apply to an area rather than a crop.

(3] Panels Panels are the result of saving a view. For example, if you
create a Data view and want to refer to it later (see

), You can save it as a panel.

(9] State icons The state icons allow you to enable or disable individual
extensions and show if a tag issued an alarm.

(10] Magnifying glass Click icon to view data in Data view.

Overview of state icons

> Enabled The green triangle in the bottom left corner indicates the
(bottom left) tag is enabled (see ).

» Executive If a tag is proceeding, a recalculation is carried out (see
(blinking bottom ).
left)

Disabled The gray square in the bottom left corner indicates the tag
(bottom left) is disabled or disconnected (see
).

A Alarm not If a tag issued an alarm, an alarm icon will be shown in the
acknowledged Explorer window by that tag. Acknowledge of alarm (see
(bottom right) )-

A Alarm The alarm has been acknowledged (see
acknowledged )-

(bottom right)
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As the main window in addVANTAGE Pro, the Explorer offers many features. In
addition to the usual expand/collapse of branches by clicking the plus (+) or
minus (=) sign, you can rename a node.

Rename Node
Follow these steps to rename a node (see ):
Click once to highlight the node you want to rename (left side of ).

PN

wow| B

Click the node again to turn the name into an edit field.
Type the new name.
Press the Enter key.

Figure 5. Renaming Nodes
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You can also right-click a node and see a variety of options on the Context
menu, depending on the node type and the permissions your user ID has.
, for example, shows the Context menu for a tag for someone with

admin permissions.

Figure 6. Right-clicking a Tag in Explorer, Context Menu

New Node

Mew node

]

Mew node from template *

| Show only data
Show only events

Manual event...
Connect
Reload data...
Change values manually
¥ Delete

ﬂ Explore from here
4| Search from here...

=
|

= Settings...

Create nodes such as areas, panels, extensions, crops, and tags.

New Node from Template
Create nodes such as panels or extensions, crops, and tags from a saved

template.

Show only Data

Open a Data view in the Graph view mode showing data from the node's

children.

Show only Events

Open a Data view in the List view mode showing the events from the node's

children.
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Manual Event

When you right-click a node in the Explorer, you’ll see a Manual event choice.
Select it to display a dialog similar to the one shown in

Figure 7. Creating a Manual Event

Source: Adcon Klosterneuburg

Begin Oct 6, 2016 1:54 PM .
Date: Europe/Vienna
Duration: d h m

Severity: Event -

Comments:

OK | Cancel |

1. In the Begin Date field, enter or select the date you want to be associated
with the event. The wording shown to the right of the calendar icon
indicates the server’s time zone.

2. Leave the Duration fields blank if this is a currently active event. Otherwise,
enter a zero for days, hours, or minutes to indicate a simple, one-time
event.

3. Select a Severity level from the drop-down. Your selection determines
whether the manual event is shown as an Alarm, Event, or entry in the
Service log.

4. Enter the Comments that will be displayed in the Events viewer.
5. Click OK to close the dialog.

Connect
Connect the node to the server by selecting the server and choosing the device

from the dialog that appears.
Reload Data

When retrieving, the data is deleted from the local database. If these
are no longer present on the source, there is a risk of data loss!

Retrieve data from the server.

You need another addVANTAGE Pro server, or an A850 Telemetry Gateway with
the latest firmware release, to be able to retrieve remote data.

Change Values Manually

You might find that the values on one sensor have data errors or need to be
marked as bad. You can use this feature to change the values manually. Follow
these steps:

1. Right-click the tag whose values you want to replace.

Automatic filtering takes place after appropriate tags. The Explorer shows only
those tags that are compatible and suggests them for selection.
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2. Select Change values manually to display the dialog shown in
Target: shows which value you selected to change.

Figure 8. Change Values Manually Dialog
Target: Incoming RF Level

Copy values from another tag - Source: \I\

Start time:  October 19, 2016 [ 4 0000 =5
End time:  October 19, 2016 [ o 2359 =5
OK | Cancel |

3. Click the down arrow next to Source to choose what you want to do:

o Copy values from another tag
Select this when you know another tag has the correct values and you
want to copy them to the current tag. Continue with step

. Mark values as BAD
Select this to mark a range of values as incorrect. Skip to step

o Remove manual values
Select this to replace manual values with automatic values for a range.

Skip to step
4. Click the Source field to display a Tag Chooser dialog similar to the one
shown in .
Figure 9. Tag Chooser Dialog
= ﬂ addVANTAGE Pro 6 - DEMO SERVER {41) &

=, . Area 6.6 (20135)
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addTimer (20219)
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Temperature Statistic (20159) -

m

-]

TEH T 'H’@ﬁ

OK | Cancel |

5. Choose the appropriate station, then select the tag with values you want to
copy.

6. Click OK to return to the Change Values Manually dialog.

7. Enter the Start time and End time for the values to copy, mark as bad, or
remove.

8. Click OK.

If you copied values from another tag, you'll see that where the values for
both sensors are the same, the old are overwritten by the new and are
highlighted in red in the Table view.

Explore from Here
Open a new Explorer with this node as the root.

Search from Here

Search only this part of the Explorer.
Settings

View and edit node-specific information.
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The Menu bar and Tool bar in the Explorer ( ) provide different ways to
access the features of addVANTAGE Pro 6.6.

Figure 10. The Menu Bar and the Tool Bar

o o o o
L 1 |

Tools Window Help Logout

00 006 O 10}
Menu Bar
(1) Tools Accesses addVANTAGE Pro user options and other
administrative tools.
(2] Window Refreshes the current window and allows you to select an
addVANTAGE Pro window when multiple windows are open.
(3) Help Displays the documentation and information about the
software.
(4] Logout Exits the addVANTAGE Pro software.
Tool Bar
(5] RTU Creation Starts a wizard that helps you create an RTU
Wizard (see Administrator Manual).
(6] New Panel Creates a new Explorer, List, Data view.
(7] Settings Shows the settings of the selected node.
(3] Delete Deletes objects you have selected in the Explorer.
(9] Search Type Provides a quick search option to select an object from the
pop-up and then type search criteria in the text field.
(10] Search Displays the Advanced Search dialog with more specific

options.
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Chapter 3. Node Settings and Tools

The robust settings and tools features in addVANTAGE Pro are the building
blocks of the system. Settings let you tinker with node settings such as whether
a node is connected to the server and what to do when a threshold is reached.
The tools options affect system-wide settings such as data acquisition and E-
mail.

The tabs you see on the Settings dialog depend on the node type and, in some
cases, your user role.

Node Settings

When you right-click a node in Explorer and select Settings, you have the option
to view and edit various features related to the node. The dialog that appears
(Figure 11) has three default tabs—General, Action, and Security—but might
have additional tabs, depending on the node type and your user role.

The General tab displays certain information about the node, such as its location
and name. The Action tab enables you to set events and actions specific to the
node itself. The Security tab shows the node’s owner and the permissions
various groups have in relation to the node.

Node General Settings
Figure 11. General Tab of Node Settings Dialog

General | Action | Security |

'JD Adcon Klosterneuburg

Location: faddVANTAGE Pro 6 - DEMO SERVER/. Area 6.5/Area 6.5/Adcon Klosterneuburg
Class: AREA

Subclass:

Node 1D: 20138

Alarms: 0 total, 0 acknowledged.

Events: 0 total, 0 acknowledged.

Service logs: 0 total, 0 acknowledged.

Time zone:  Europe/Berlin

Attributes... |

ok | Cancel | Apply |

Node Action Settings

With the Action tab, you can specify the action that a certain event will cause.
Figure 12 illustrates the sequence that occurs when an extension’s threshold
event is Treatment recommended and action is E-mail.

Figure 12. Node Action Setting

Input Tag Extension [Eerziic Action
(Treatment

recommendet)

(Temp sensor) (Desease model) (E-mail)
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o The extension registers itself as listener on the input tag (e.g. the Temp
sensor) as soon as you set the Temp sensor as an input tag (see

o As soon as new measured values from the input tags are retrieved, the
calculation is updated and, if necessary, an event is triggered.

o A possible event of this extension is the “"Treatment recommended” event.
This means when you open the Action tab of this extension, the table
shows the "Treatment recommended” event.

o For this event, you might choose to send an E-mail. As soon as this event is
issued, the E-mail is sent to the defined recipients.

In any case, an issued event is always written to the node's Event list.
shows the Action tab of the Node Settings dialog.

o
2]
(3]

Figure 13. Action Tab of Node Settings Dialog

General | DACQ Info | Action | Thresholds | Security |

Event | Action | Max. age of event
Threshold reached E-mail 1d
Sensor removed E-mail 1d
¥4 (1]
0K Cancel | Apply |

Add Add actions to the list

Edit Edit actions

Remove Remove actions from the list

1. Click the Add button to display the dialog shown in

Figure 14. Adding an Action

Node: Adcon Klosterneuburg
Event: Manual event -
Action: E-mail -
Max. age of event: fd h m
Recipients:

OK | Cancel |

2. Select an Event from the list. The choices in the Event list depend on the
node type. For a tag, the choices might include problems with the data or a
threshold being reached. Manual event is a choice for every node type.

3. Select an Action from the list.
The following actions are available, depending on the node type:

Landline call (SIP/VoIP) uses the Session Initiation Protocol (SIP) to
make a landline call through the Voice over Internet Protocol (VoIP) to
the Recipients you specify in the field below. For recipients who are
also system users, you can enter a shortcut in the format user{name},
such as user{root}. You can also specify a group as a recipient, such
as group{admin}. The user’s phone number, or the phone numbers of
each member of the group, must be set in the system.

When you select this action, you must enter the appropriate Phone
numbers and, optionally, select the Soundfile you want to be played.
E-mail sends an E-mail to the Recipients you specify in the field below.
In specifying recipients, you can enter full E-mail addresses in the
format: name@address.extension. For recipients who are also system
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users, you can enter a shortcut in the format user{name}, such as
user{root}. You can also specify a group as a recipient, such as
group{admin}. For multiple recipients, the order does not matter but
you must separate each with a semicolon:

user{name}; john.doel@adcon.com;user{root}

In order to successfully send E-mails from addVANTAGE Pro, the E-mail service
must be properly configured.

Switch On switches on an output port of an RTU.

Switch On/Off switches on an output port of an RTU and instructs it to
switch it off automatically after a predefined time elapses.

Switch Off switches off an output port of an RTU.

If you defined the rule to issue a command (Switch On, Switch Off or
Switch On/Off), you must click the Node button to select the tag to be
acted upon. In the case of Switch On/Off, you must also specify how
long the switch should be on (Open time)

4. Enter the day (d), hour (h), and minute (m) of the Max. age of event. Older
events are suppressed and no action is triggered.
This field is helpful because you would likely find an event that happened

two years ago uninteresting and you certainly wouldn’t want a SIP call
made because of it.

Enter an appropriate value for Max. age of event—for example 1 day—to avoid
resending lots of outdated E-Mail notifications (e.g. when the server gets
restarted due to any reason).

5. Click OK to close the Add Action dialog.

6. When you're finished with the Settings dialog, click OK to close it.

The next time the event you specified occurs in the node, the action you
specified will happen. You can Edit or Remove only those actions you created.



addVANTAGE Pro 6.6 User Manual CHAPTER 3
Node Settings

Use the Security tab ( ) to set permissions for the node.

All of these settings show default values for the node. The Security tab shows
the owner and to whom the node belongs to. You will rarely need to change
these settings, but you might want to assign different Privileges. Whether you
can assign different privileges is determined by your account permissions.

Read and Write determine whether the node can be viewed (read) or edited
(write). Therefore, you can use this dialog to determine the permissions the
Owner of the node, the Group the node belongs to, and Everyone else has. You
can also select None for any of the fields to prevent anyone from viewing or
editing the node.

Figure 15. Security Tab of Node Settings Dialog

General | Action | Security |

Ownership
Owner: root -
Group: admin -
Privileges
Owner: Read & Write -
Group: Read Only -
Everyone: Read Only -

Children Nodes

New children nodes will have Default privileges from user -

Availability

Accessible from outside addVANTAGE Pro

Apply to all child nodes

OK | Cancel | Apply |

For Children Nodes, you select whether to have child notes get the same
privileges as the user or the privileges of the node.

also shows the Availability section. If you select the checkbox, also
users without a login details will be able to see the node. Select the checkbox
Accessible from outside addVANTAGE Pro to make the result publicly available.

If you want the security permissions to apply to all the nodes that the current
node is the parent of, click the Apply to all child nodes button.

Following is a discussion of the tab options for specific node types.

If you right-click a panel in the Explorer and select Settings from the Context
menu, the dialog shows only the three default tabs. To set up Lists and Data
view panels, see .
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If you right-click an extension or a crop in the Explorer and select Settings from
the Context menu, the dialog shows the default tabs illustrated in

Figure 16. Default Tabs for Crop and Extension

General | Crop | Treatments | Irrigation | Action | Security |

Grapes 2009

General | Extension

(=3

Advanced settings

Conditons

To set up Extensions and Crops, see

Inputs

Action | Security

shows you the Settings dialog for a tag. One difference between RTU
and tag settings is that you can set thresholds for a tag. A discussion of the
Thresholds tab begins on

Figure 17. General Tab of Tag Settings Dialog

General | DACQ Info | Action | Thresholds | Security |

Batt Adcon Klbg

Location:

Class:
Subclass:
Node 1D:
Alarms:
Events:

Service logs:

Template:

Engineering
unit:

Number of
values:

First value:
Last value:

Last config
update:

Time zone:

faddVANTAGE Pro 6 - DEMO SERVER/. Area 6.5/Area 6.5/Adcon

Klosterneuburg/Adcon Klosterneuburg/Batt Adcon Klbg

TAG

BATT

20155

0 total, 0 acknowledged.

0 total, 0 acknowledged.

0 total, 0 acknowledged.
ABS0_ANALOG_TAG_INTERNAL_V1

3500 (EL voltage (volt)), 2 digit(s).

543201

Dec 6, 2005 1:02:38 AM: 6.82 V
Oct 19, 2016 11:45:00 AM: 6.90 V

Oct 6, 2016 4:43:05 PM Update config now!

Europe/Vienna

Attributes... |

OK

| Cancel | Apply
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The other difference between RTU and tag settings is the addition of the Climate
setting for an RTU immediately above the Attributes button ( ). You use
this setting to select the type of climate applicable to the RTU’s location. You can
also click Detect by GPS to automatically select a climate setting based on GPS
coordinates.

Figure 18. Climate Setting on RTU Settings Dialog

General | DACQ Info | Action | Security

Il-j Adcon Klosterneuburg

faddVANTAGE Pro 6 - DEMO SERVER/. Area 6.5/Area 6.5/Adcon

Local Klosterneuburg/Adcon Klosterneuburg

Class: DEVICE
Subclass: Weather
Node 1D: 20139
Alarms: 0 total, 0 acknowledged.
Events: 0 total, 0 acknowledged.
Service logs: 0 total, 0 acknowledged.
Template: ABBO_ATI3_VT7
Last config o . -
amiE Oct 6, 2016 4:43:05 PM Update config now! |
Time zone: Europe/Vienna
Climate: Warm temperature - fully humid - warm summer - Detect by GPS | ‘
Attributes... RTU Motes...
OK Cancel Apply

Review the General tab for information about the tag, such as its class and
subclass, node ID, number of alarms, events time zone of its server, and so
forth.

Updating the addVANTAGE Pro Configuration

The tab also shows you the last time the software configuration database entries
were updated, which will usually be midnight of the current day, unless it’s set to
update at another time. However, if you don’t use automatic configuration—or if
you just want to update the configuration now—click the Update config now!
button. The system retrieves the current configuration from the server and
updates the local one. If any special conditions are reached, an event could be
issued (for example, if you specified an action based on an event such as the
engineering units being changed, the event would be registered).
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Viewing Node Attributes
The General tab has an Attributes button. Click it to display the dialog shown in

Figure 19. The Attributes Dialog

Name Type Value | |
active BOOLEAN true -
altitude DOUBLE 0.0
batteryVoltage DOUBLE 7.29412
code INTEGER 77
dataDelay INTEGER 12
date DATE Tue Apr 19 17:44:18 CEST 2016 =
firstSlot DATE Sat Mov 14 06:30:00 CET 2015
frequency DOUBLE 4.3941E8
internalTemperature DOUBLE 15.1373
lastSlot DATE Wed Apr 20 00:10:00 CEST 2016
latitude DOUBLE |48.2894
longitude DOUBLE 16.344
manufacturer STRING |adcon Telemetry
master EQOLEAN true
maxDataDelay INTEGER 21600
notesTimestamp INTEGER 315532800
npnd BOOLEAN true
pmpHigh DOUBLE 7.2
pmpLow DOUBLE 6.5 -

This dialog shows technical information about the tag’s attributes. You close the
dialog by clicking the X in the upper right corner.

As shows, use this tab to view information about the source and
connection status of the tag.

Figure 20. DACQ Info Tab of Tag Settings Dialog

General | DACQ Info | Action | Security |

Data source: hosto1 7

Remote source ID: 14036

Status: CONNECTED Disconnect! |

If you disconnect an RTU or tag on the DACQ Info tab, you will need to right-
click the node in the Explorer and select Connect to » /fostname. Then select the
device in the dialog that appears.

Note: When a tag is acquiring data, the icon for the tag and for the RTU will display in
the Explorer with a tiny moving arrow.
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Use the Thresholds tab ( ) to set conditions that will trigger an alarm,
event or service log entry when a threshold has been reached.

Figure 21. Thresholds Tab of Tag Settings Dialog

General | DACQ Info | Action | Thresholds | Security |

Conditions

Create "Threshold reached” event when:

ALL conditions were met ~

Condition Value1 Valuez Unit |

is greater or equal to 5 v * o
—0
—O
Event
Severity: Event v
Remark:
OK I Cancel | Apply I
(1) Add Add actions to the list
(2] Edit Edit actions
(3) Remove Remove actions from the list

One of the actions you can set on the Action tab is for the Threshold reached
event. Use the Thresholds tab to create the threshold that causes the action to
occur, as detailed in the following steps:

1. Select whether to Create “Threshold reached” event when” one of these
choices is true:
. ALL conditions were met
. ANY condition was met
2. Add one or more conditions:
a. On the right side of the Conditions pane, click Add.
The dialog shown in is displayed.

Figure 22. Adding a Threshold Condition

Condition: | is greater than

Valuel: 0wV

0K J Cancel J

b. Click the Condition drop-down to select the threshold’s condition.
Following are the choices in this drop-down:

e s greater than
e is greater or equal to
e isequalto
e isless or equal to
e isless than
¢ is between (incl)
The values are inclusive.
¢ is between (excl)
The values are exclusive.
¢ is between (incl - excl)
The values include the first but exclude the last.
¢ is between (excl - incl)
The values exclude the first but include the last.
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c. In the Valuel field, enter the condition’s value.

d. If you used any of the “between” conditions, enter the other value in
the Value2 field that appears. The following table describes how values
are used with these conditions.

Condition Sample Value | Sample Value Condition
1 2 Applies to
is between (incl) 2.0 5.0 2.0, 3.0,
4.0, 5.0
is between (excl) 2.0 5.0 3.0, 4.0
is between 2.0 5.0 2.0, 3.0,
(incl - excl) 4.0
is between 2.0 5.0 3.0, 4.0,
(excl - incl) 5.0

e. Click OK to close this dialog and continue with adding a threshold.

3. In the Event pane, click the drop-down to choose whether this threshold
will result in an Alarm, Event, or entry in the Service Log.

4. Add a Remark to be displayed with the alarm, event, or service log entry.
(optional).

Use the Tools menu for administrative tasks such as setting users and groups,
administering data sources, administering chemicals (for Plant Protection
extensions), and so on.

Figure 23. Tools Menu Dialog

Tools Window | Help | Logout
& User options...

JEMO SERVER (41)

& Server settings »
Database 4
_. 7)
& User management b erneuburg (20138)
E Data acquisition osterneuburg (20139)

Get data from Adcon Klbg (20155)
Chemicals al A (20151)

ning RF Level (20147
il node template tibrary |0 { i
Wetness (20152)

_bing RF Level (20141)
PyranometerCM3 (20148)

-

Climate manager

The menu options you see depend on your user role, but following is a sample of
the options:

. User options

o Server settings

o Chemicals database administration (only if at least one Plant Protection
extension is installed)
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To change options in your addVANTAGE Pro user profile, select Tools » User
options in the Explorer window. The dialog shown in appears.

Figure 24. User Options Dialog, My Settings Tab

My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

Language: English -
User: admin_text-it

Full Name:

Description:

Phone number:

E-Mail address:

OK Cancel Apply

Use the My Settings tab to view or change various settings:

o Select the Language drop-down to choose the language used by

addVANTAGE Pro during your sessions.

. Enter or update your Full Name, Description, Phone number, or

E-Mail address.

Use the Panels tab ( ) to view or change default options for Data view
and all panels. You can change all of these options separately when you work

with panels, as described in
Figure 25. User Options Dialog, Panels Tab

My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

—Options for all panels

Closing a panel that was never saved Ask to save changes ~

Closing a panel that is already saved as node .y t save changes ~

Show seconds in panels

Re-open last opened panels when log in

—Data view options

Default type for data view panel when clicking View Data: Graphical view -

L]

I~ | Default background color for graphic

L]

I~ | Default background color for axis

u

Default background color for legend

R

Font color of legend

u

Default color of time axis

Default field delimiter for CSV export: Semicolon ;) -

—Events options
When using "Show events” explorer sub menu, create an event with following options:
/| Show alarms

+| Show events

OK Cancel Apply
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Optlons for all Panels
There are two drop-downs, one for saved and one for unsaved panels. The
drop-down indicates the behawor of addVANTAGE Pro if the user closes the
panel, if addVANTAGE Pro should discard changes, ask the user to save or
save automatically.

o Select whether to see seconds when displaying time in a panel by clicking
Show seconds in panels.

J If you prefer to always open addVANTAGE Pro with the panels you
previously used open, select Re-open last opened panels when log in.

Data View Options
These options serve three purposes:

o At the top of the section, select the default view to use for a Data view
panel you create when you select View Data from the Context menu: Graph
view, Table view, Event list, Virtual instrument or Map view.

. From the boxes that follow, define color defaults for the all views of new
Data view panels. You cannot use this dialog to change the colors in open or
existing Data view panels.

o Use the last drop-down in this section to select the character to be used as
the Default field delimiter for CSV export. When you export a Data view into
a CSV file, this option shows the character used to separate columns in the
file.

Events Options

Use these checkboxes to determine whether a new Event list should Show
alarms, Show events, or show both.

Use the Explorer tab ( ) to display the internal ID of each object in the
Explorer. You probably won't need to activate Show Node IDs under normal use,
but it can be valuable when you need technical support. You can also use this
tab to automatically install RTU diagnostics when you add RTU stations in
Explorer.

Note: Before you contact our support team, please have your Node-ID shown in the
Explorer available.

Figure 26. User Options Dialog, Explorer Tab
My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

| Show Node IDs
["] By default, install RTU diagnostics when a station is created

‘ OK | Cancel | Apply |

Figure 27. Node-ID in Explorer
amlB A

I}\ addVANTAGE Pro 6 - DEMO SERVER (41)

=- [}, . Area 6.6 (20135)

= Il Area 6.6 (20137

IL Adcon Klosterneuburg (20138)

Adcon Klosterneuburg (20139)
Apple 2016 *20163)
Banana 2016 (20188)

:~‘ DSV (20189

s

¥ ETc (2019)

, Generic Model for Downy (20192!

-

al--g-a
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Use the Crops tab ( ) to view or change the Crop default start date, that
is, the date to start collecting data about the crops.

Figure 28. User Options Dialog, Crops Tab
My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |
Crops default start date: 1 = January -

#| Show crop in the Explorer context menu

Visible crops in Explorer menu:
J| Apple

Apricot

Banana

Barley

Bean

Beet

Cacao tree

m| e

< =L E NS S

Carrot -

Check all Uncheck all

/| Automatically install crop extensions when crop is created.

OK | Cancel | Apply |

This dialog shows which crops will be visible to the user in the Explorer Context
menu. If a crop is not selected in this list, the user cannot add it to a node.

You also see an Automatically install crop extensions when the crop is created
checkbox. The addVANTAGE Pro software can automatically include disease
models and calculation extensions (collectively called crop extensions) usually
associated with the crop. If you select this checkbox, those defaults are
automatically added with the crop when it is added to a node. If this checkbox is
not selected, only the crop itself is added to the node. The user can select the
crop extensions separately—but only the extensions that are associated with the
crop.

If a specific crop extension has been made invisible on the Extensions tab (as
described next), the extension will not appear in any list of disease models or
calculation extensions that can be added to the crop.

Your ability to edit this dialog depends on your user role.
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Use the Extensions tab ( ) to select whether to Show advanced settings
in extensions. All existing extensions are displayed. If selected, the Advanced
settings tab displays in an extension’s Settings dialog (see

Figure 29. User Options Dialog, Extensions Tab
My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

Show advanced settings in extensions

Visible extensions:

addTimer -
[] Battery charging

[T Bunch Rot (Broome model)

[[] cercospora Leafspot

[7] chill/Heat Hours

Conditions

[7] Constant value detection

[[] Degree Days

[[] Dew point

[[] Downy Mildew

[] Downy Mildew (Kast PeroDiag model)
[C] Drop Detection

[ psv

7] ETc

[Tl ETo

[T] Fire blight (Cougarblight model)
[C] Fire blight (Maryblyt model)

[7] Flow To Volume

[7] Formula Calculation

m

[[] Generic Export il
Check All | Uncheck All |
OK | Cancel | Apply |

You can also make the various calculation extensions and disease models visible
on the Context menu. If you create a new node, only the selected extensions are
visible ( ).

Figure 30. Extensions on the Context Menu, New Node

<=2 |~ I S

=[], addVANTAGE Pro 6 - DEMO SERVER (41)
=}, . Area 6.6 (20135)

=}, Area 6.6 (20137)

E'ﬂ Adcon Klostrrmnsshuswn 30401

E-k Adcon K New node 4 'JD Area
EJ---& Apple 21 Mew node from template * | == Data view
[ Banana Calculation extension 4 Conditions
sh I ts . . .
& i Tomato oW only even Meteorological extension » &, addTimer
""" O addTim # . Export extension 4
=8 conditic # Manual event... p
=8 E£To (20 ¥ Delete % crops 4

7] Daily ll-;| RTUs/Tags from 4

1~ Hour ﬂ Explore from here

w-E Heat Iny %] search from here...
EII--- Temper
----- c= Adcon-C = Settings...

----- c= Wind direction2 (20230)

Note: Your ability to edit this dialog depends on your user role.
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Use the Engineering Units tab ( ) to change the engineering units used
to express the tags.

Figure 31. User Options Dialog, Engineering Units Tab
My Settings | Panels | Explarer | Crops | Extensions | Engineering Units | Security |

Systemn: Impaerial -
Original Engineering Unit:

Lrea |are) -
Area [hectare)

Area (square centimeter)

Area [square decimeter)

Brea [square foot)

Area [square inch)

Displayed Engineering Unit:

Area [hectare)
Area [square centimeater]
Area [square decimeter]
Area [square foot)

@ Area [square inch)

OK | Cancal | Apply |

Use the System drop-down to choose how engineering units will be displayed to
you. Metric and Imperial provide a set of default units that are either metric or
American. For example, shows that the original engineering unit for
Area (square centimeter) in the Metric system will be displayed as Area (square
centimeter). If you select the Imperial system, the displayed unit changes to
Area (square inch).

You can also make specific selections for one or more of the original engineering
units. To use a different displayed unit, select the Custom, system and click the
Radio button indicating the unit you want to be displayed, such as Area (square
foot).

To change the engineering unit for a specific tag in addVANTAGE Pro, do the
following:

1. Find the engineering unit you want to change in the upper panel of the
dialog and select it.

Valid alternatives are displayed in the lower pane. Select the one you want.
Click Apply to save changes.

To change other engineering units, repeat steps 7 through

When you are finished, click OK to close the dialog.

Your ability to edit this dialog depends on your user role.

nhwnN

Use the Security tab ( ) to view or change security settings associated
with your user profile.

Figure 32. User Options Dialog, Security Tab

My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

User: dimi

Mew Password: ssss

Confirm Password; sane

Crweniar: Fiead & Write -

Group: Fiead Only -

Everyone: MNane -

Saession time out: 60 min: 5 minutes; max: 60 minutes
Heed the password for WaP p

access

0K Cancel Apply
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You can change your password and account privileges, as well as the duration of

your session timeout and whether you must use your password for WAP access
to addVANTAGE Pro.

Some users will see only the User’s name and the password fields. Your ability to
edit this dialog depends on your user role.

Adcon does not supply lists of chemicals because the rules for their use differ
between locations. For more details about this service, please consult the
addVANTAGE Pro Extensions and Crops manual.



Lists and Data view are panels that offer different ways to view data in
addVANTAGE Pro.

You can right-click any panel use the Copy, and Paste & Reconnect options to
duplicate the panel in another part of the Explorer. You can save a crated panel
using the Save button.

Use the List to display a group of addVANTAGE Pro objects in a different way.
The List is similar to an Explorer view, with the difference that the objects in a
list are not expandable. Use a List when you need to work on a group of objects
with similar settings, for example, configure extensions or synchronize tag

settings.
You can create a List by clicking the New Panel button in the Tool bar and
selecting List. Use the Add Nodes button on the List’s tool bar ( ) to add

objects to the list. You can also remove objects that you no longer need by using
the Remove Nodes button on the Tool bar.

Figure 33. List Tool Bar

Tools Window Help Logout

06 60
(1] Save Save new added nodes or reworked nodes.
(2] Save As Save new added nodes or reworked nodes as a new
position (under a new name).
(3) Add Nodes Add objects to the list.
(4] Remove Nodes Remove objects from the list.
Note: Removing an object from the list does not permanently delete it from the

database. You will continue to see the object in an Explorer panel. To
permanently remove an object, right-click it in the Explorer and select Delete.
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When you add objects to a list from the List’s tool bar, the Choose Nodes dialog
opens, as show in

Figure 34. Choosing Objects to Add to a List

= ﬂ addVANTAGE Pro 6 - DEMO SERVER (41) -

=, . Area 6.6 (20135)

=l Area 6.6 (20137)
= ﬂ Adcon Klosterneuburg (20138)
L5 Adcon Klosterneuburg (20139)

é Apple 2016 (20163)
=& Banana 2016 (20188)

=@ psv (20189)
< Accum. Index (20191)
~| Daily index (20190)
ETc (20196)
Generic Model for Downy (20192)
Tomato 2016 (20199)
addTimer (20219)
Conditions (20220)
ETo (20209)
Heat Index (20212)
Temperature Statistic (20159) -

m

i,

i

T 'E’Oﬁ+ +

i

OK

Cancel |

Select an object in the dialog and click OK. You can add only one object at a
time.

If you're using Internet Explorer, you can also add objects to the List by
dragging-and-dropping them from an Explorer into an open List. If you're using
Firefox, you can drag-and-drop an object onto the saved List’s icon in an
Explorer.

You can also create a list as a result of a search operation. Suppose you want to
search for all areas in the system having the string "Adcon” in their name.

Follow these steps to search for those areas and populate the List:

1.

In an Explorer, click the Search icon (the magnifying glass icon on the right
side of the text box in the Explorer tool bar) to open the Advanced Search
dialog (

Node name is dlsplayed by default, with the default setting of contains.
Enter Adcon in the text field.

Click the Add criteria drop-down, then select Class.
Another line of search parameters is displayed in the Search dialog.

You can also search by Name, Subclass, ID, and Attribute. Each type of
criteria has its own settings. Click the down arrow to see those settings.

Keep the default setting of is, but from the next drop-down, select Area.
Click the OK button.

Figure 35. The Search Dialog

Search In: /

Search for nodes whose:

Mode Name contains + Adcon b4

and Class is + Area - b4

Add criteria... «

OK Cancel
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Note:

The List

A List appears ( ), containing all the objects fulfilling the selected
criteria. After performing the required operations on the nodes in the list, you
can save the list as a panel or discard it by closing it.

Figure 36. A List Viewer

# ‘ Name | Location
ll 46331 54 - adcon test outside faddVANTAGE Pro 6 - DEMO SERVER/.PLAYGROUND - will be deleted every 1st day of a month/KNOTS/
ll Adcon Klosterneuburg faddVANTAGE Pro 6 - DEMO SERVER/Demao Custorners/Renomia SK/
ll Adcon Klosterneuburg FaddVANTAGE Pro 6 - DEMO SERVER/Wegenernet/
.}\ Adcon Klosterneuburg /addVANTAGE Pro 6 - DEMO SERVER/. Area 6.5/Area 6.5/
ﬁ Adcon Klosterneuburg /addVANTAGE Pro 6 - DEMO SERVER/Meles/
ﬂ Adcon Klosterneuburg faddVANTAGE Pro 6 - DEMO SERVER/Dema Customners/Novax/
ll Adcon Klosterneuburg /addVANTAGE Pro & - DEMO SERVER/Demo Customers/A2 technic/
ll Adcon Klosterneuburg FaddVANTAGE Pro 6 - DEMO SERVER/MAGAP/
Adcon Klosterneuburg /addVANTAGE Pro 6 - DEMO SERVER/Dow Argentinas
Adcon Weather Test RTU /addVANTAGE Pro 6 - DEMO SERVER/.. TEST AREA/test_extension/
ﬁ Adcon Weather Test RTU faddVANTAGE Pro 6 - DEMO SERVER/.PLAYGROUND - will be deleted every 1st day of a month/Test SV/
ﬂ_ Adcon Weather Test RTU faddVANTAGE Pro 6 - DEMO SERVER/Syngenta CH/
ll Austria - Adcon Klosterneuburg /addVANTAGE Pro 6 - DEMO SERVER/Agricultural disease management/

[P Austria - Adcon Weather Test RTU Klo/addVANTAGE Pro 6 - DEMO SERVER/Agricultural disease management/
Austria - Klosterneuburg @ Adcon /addVANTAGE Pro 6 - DEMO SERVER/Environmental & Weather datas
.}\ MOE_Weather ADCON KLBG /addVANTAGE Pro 6 - DEMO SERVER/Demao Customers/BICU Micaragua/

|Copyright © 2001-2016 Adcon Telemetry. Al rights reserved. Administrator manual

A quick search option is also available:

1. Click the magnifying glass icon on the left side of the text box in the
Explorer tool bar).

2. Select the search criteria (Name, Class, Subclass, or ID). Add and
remove the search criteria as needed.

The search starts from the node you selected in the Explorer.

3. Type the string you are searching for and confirm it by pressing the Enter
key.

A list with the criteria you entered is displayed.

You can also right-click a node in the Explorer and select Search from here. The
Search dialog shown in is displayed, but the Search in line shows the
node where you started the search. Complete the Search dialog as described
previously.

A list is a collection of nodes you want to treat as one object. For this reason,
you should view settings only on the items in the list. The list itself has no
properties, and no dialog is displayed if you click the Properties button.
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Use the Data view panel to see a plot of tag values stored in the database. To
open a Data view, click New Panel and select Data view in the Explorer tool bar. The
Data view tool bar is shown in

Prior to explaining the ways to display data in a Data view, please make yourself
familiar with the Tool bar and its elements, which you will frequently use in your
daily work with addVANTAGE Pro 6.6.

Figure 37. Data View, Tool Bar

TEHIYTTIEEERL - LEETEl - T EL bR
| [ ] | [ ] | |
0000600 6 0 O @ ® ® O ® DPOOOD DD

(1] Save Saves the current panel. If this panel has not
been saved before, clicking this button opens
a dialog to save it.

(2] Save as Opens a dialog to save the current panel with
a different name. If the current panel has not
been saved before, this button functions the
same way as the Save button.

(3] Add to node template Opens the template library dialog.

(4] Print Prints the Data view on the default printer.

(5) Export all values in Saves the values shown in Graphical or Table

time range to PDF view as a PDF file.

(6] Export all values in Saves the values shown in Graphical or Table

time range to CSV view as a CSV file.

(7] Show Settings Opens the Data view Options dialog, where
you set the options for each object in the
panel, or add/remove objects from the panel.

(3] Go to Begin Sets the starting date of the Data view panel
to the beginning date of your database.

(9] Go 30/7/1 Days back Moves the starting date of the Data view
panel 1, 7, or 30 days back.

(10) Go back X Goes back the specified period of time, where
X is the span shown in 11.

(11) Date Chooser Shows the start date of the Data view panel.
Clicking the calendar icon to the left of the
Date Chooser opens a calendar you use to
select a specific start date.

(12) Go forward X Goes forward the specified period of time,
where X is the span shown in 11.

® Go 1/7/30 Days Moves the starting date of the Data view

forward panel 1, 7, or 30 days forwards.

(14) Go to End Sets the end date of your database at the

end of the currently selected span. If you
have, for example, selected to view a 7 day
span, and you click Go to End, the Data view
panel will show you the data of the last 7
days of your database.
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Graphical view

Table view

Event list

Virtual instruments

Map view

Show Values at Cursor

Show events in
graphics

CHAPTER 4
The Data View Panel

Displays the time span being used in the Data
view panel. Clicking the downwards arrow to
the right of the Span Chooser opens a drop-
down with predefined time spans to choose
from.

You'll also see a Custom duration. Select this
to display the Data view Options dialog,
where you’ll select in the General tab the
Duration you want.

Displays the Data view panel’s values on a
graph.

Displays the Data view panel’s values in a
table. Table View also enables you to export
data with a mouse-click.

Shows the events that are stored in the
nodes that are linked as event source nodes.

Displays the Data view panel’s values as they
might appear on an instrument panel.

Shows a map with the location of the stations
and tags that are used in this Data view
panel.

Displays the values of each tag in a little flag
next to the cursor.

If you unselect this button, you can click and
drag to see several statistical values for the
selected area.

Displays/hides the layer that contains event
icons. Each icon represents an event/alarm.
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Expand the tree in an Explorer until you reach the desired tag, then drag-and-
drop it into an open Data view. After a short delay, the tag’s plot is displayed in
the Data view.

Note: Currently the drag-and-drop method works only if you are using Microsoft
Internet Explorer. In Firefox you can still drag-and-drop tags, but only onto a
Data view icon within the same Explorer.

addVANTAGE Pro provides another way of creating a Data view, right from your
Explorer. This is a great way to quickly create a Data view panel for temporarily
looking at data.

1. In the Explorer select the tags you want to see in your Data view (left-click
the desired tags while holding down the Ctrl key).

2. Right-click the selected tags and select Show only data from the Context
menu as shown in .

Figure 38. View Data from Explorer

w w2 |~ I S

=, addVANTAGE Pro 6 - DEMO SERVER
Elﬁ . Area 6.6

Elﬁ Area 6.6
= Adcon Klosterneuburg

¢

Adcon Klosterneuburg
Apple 2016

w5 ETc
EII---‘:'& Fire blight (Cougarblight model)
EII---‘:'& Fire blight (Maryblyt model)
EII---‘:'& Powdery Mildew (Kast OiDiz -] Show only data
EII--f Scab (Mills-Jones model) Show only events
----- £= Data view
w-&, Banana 2016 ﬂAdd to node template *
- g Tomato 206 % Manual event...
DE psv Recalculate
w8 ETc .
w- %, Late Blight (Winstel model) - COPY
----- €. addTimer ¥ Delete
EII--- Conditions
EII--- ETo ﬂ Explore from here
@-E Heat Index %] search from here...
EII--- Temperature Statistic
----- ¢2 Adcon-Check MH = Settings...
Note: If you want to keep the created Data view panel for later use, you need to save

it. You have the following options:

o Clicking on the Save button in the Tool bar and type in a name for the new
Data view panel.

e  Automatically save the panel when closing it (this option depends on the

selected function—see Tools » User options » Panels » Crops » and choose
the appropriate function).
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Showing Events in the Graphical View

You can click the button Show events in graphics to view the events and alarms
in the plot. This means each event has an icon. If you click the icon, there is
detailed information shown about the event, like the event message, the time
stamp and more. You can click the exclamation point to acknowledge that you
have seen the event. shows the events in the graphical view.

Figure 39. Showing Events in Graphical View
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(1) Tool bar (4] Plot area
(2] Legend (5] Event message
(3) Scale (6] Time line
Tool Bar
In the Tool bar you can switch between Graphical view, Event list and Map view—
see
Legend

The legend shows the values at the current cursor position. You can arrange the
legend on the side or at the top by clicking on an empty space and holding down
the mouse button to drag it to the desired position in the Data view panel.

Figure 40. Legend, Tool Bar
00 00

D Airpressure (abs) |- (5)
950.7 hPa
147417 10:20 PM
(1] Checkbox to enable or disable (4] Reconnects to the corresponding
(hide) the curve. tag.
(2] Changes color of the curve in the (5) Deletes the graph of a tag from
plot area. the plot area (not from the data
base).

Only delete a tag from the plot
area if you don 't need this
view any longer.

(3) Shows more or less detailed
information about the tag.
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Notice that each tag in the plot area is displayed in the color designated for it in
the Legend. You'll also see that the y-axis color is linked to the tag color, but you
can change that in the Data view’s settings (see .

You can plot tags coming from different RTUs on one panel. If you have tags
from different RTUs with the same name, you can easily identify them by placing
the cursor in the legend for the respective tag. After a short delay a tool tip pops
up, displaying the tag’s full path.

Scale

You can arrange the scale ranges to save space for the view.To do this, drag the
up / down arrows. You can also enter values directly by double-clicking on a
value in the scale, to select it for editing.

Figure 41. Stacking Scales
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(1] Arrows up / down (2] Enter values directly
(with double-click)

Plot Area

In the Tool bar, click on Show Values at Cursor to display the values directly on
the chart curve in the plot area.

Event Message

In the Tool bar, click on Show events in graphics to display events and alarms
directly in the Graphical view.
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Time Line
The time line allows you to change the time range for the displayed events in the
plot area.
Figure 42. Time Line

o

| |

o (2] (1]

(1) Time line sliders: select the start (2] Panning: moves the view but
and end period keeps the time period

Multiselecting Tags

You can select multiple tags to display their scales. Select the data you want
with Ctrl+Click. You can hover over a tag name in the legend to highlight the
corresponding curve in the plot area.

Figure 43. Showing Tags from Multiple Selected Entries
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If you can’t use drag-and-drop, follow these steps to display data in a Data
view:

1. In an active Data view, right-click in the Plot area and select Settings to
display the Data view Optlons dialog shown in

2. Click Add to display the Tag Chooser dialog listing the ava|IabIe tags.

3. Expand the tree until you find the tags you need to display (you can select
more than one tag by using the Ctrl key).

4. Click OK when you are finished. The selected tags are now displayed in the
Tags list, in the order you chose them.

If you need to add other tags in the Data view panel, including tags from
different areas/RTUs, repeat step 2 through step 4. To delete a tag, select it and
click the Remove button. By using the arrow buttons, you can change the order
of the tags in the list. When the Data view Options dialog lists all the tags you
want to display, click the OK button. The Data view displays the tags and their
data in a graphic form.

Figure 44. Selecting, Adding, and Removing Tags

O 6 6 O
L[ |
S EN|EN
Legend /addVANTAGE Pro 6 - DEMO SERVER/. Area 6.5/Area 6.5/Adcon Klosterneuburg/Conditions/Conditions met
Events
Map
General

Y Axis ‘ Pl.ot| Thresholds

—Axis —Grid
Use Sensor color as Axis color
"] major Grid: 4
You will use 0.25 units per gridline.
—Scale —Band
igh(): 1 High(z): 99
High(): igh():
Low(): 0 Low(%): 0
Autom. stack Overlap: %
[ Defaults ]

[7] Autom. scale in group
[7] Abways show Y-Axis

(1) Add Add tags to the list (also from different areas/RTUs)
(2] Remove Remove tags from the list

(3) Move up Change order of the list

(4] Move down Change order of the list

If no plots are displayed, check the date and use the arrows and the calendar in
the Data view to move to a date and time where data is available.

You can also use the extensive features available in the Data view Options dialog
to customize the way your plot area looks by viewing and changing the options
on the Y-Axis, Plots, and Thresholds tabs. As you make changes in this dialog,
you can click Apply to see how the changes affect the Data view before you save
the changes. If you're satisfied with the changes, click OK to save the Data view
panel.
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Following is an explanation of the options on the Y-Axis tab shown in

o Use sensor color as Axis color. The Y-Axis and sensor colors are assigned by
addVANTAGE Pro and are identical by default. If you leave this checkbox
unselected, you can use the color chooser you see to change the y-axis
color, but the corresponding color of the tag on the curve will not change. If
you select this checkbox, the color of the y-axis will be the same as the
sensor color (as displayed on the Plot tab).

o Scale
o High /Low: The scale refers to the tag’s value range—in other words,

the maximum or minimum value that is expected. Enter relevant
values, because otherwise you will not see the chart curve.

Normally, only people who know that their value is within a certain
range use the Scale fields. For example, say you have a special Temp
sensor in a production process. Its range is always between 20°C and
25°C but it is very important to see small changes. For this sensor, you
would choose settings of Low=20 and High=25.

e  The Defaults button resets the High/Low settings to the tag’s default.

o Use Automatic scale in group to display the scale as an average of the
High/Low settings for the tags in a chart. You can display multiple groups of
such autoscaled sensors by assigning each to a group. Groups are entirely
arbitrary and of your own making. Group numbers need not be consecutive.
If you don't assign a sensor to a group you will see the High/Low settings
only for the selected sensor.

o If you select the Always show Y-Axis checkbox, the y-axis for the current
sensor (meaning the sensor whose y-axis settings you are viewing) will be
shown on the grid always, even when another sensor is selected. Normally,
when you select a sensor in the Legend section, the y-axis is refreshed and
the scale of the selected sensor is shown. However, if you select the Always
show Y-Axis checkbox, you will see the current sensor’s y-axis and the y-
axis for the sensor you select in the Legend.

o Use the Major Grid to show horizontal grid lines. The number you enter
defines the interval for the Y-Axis. For example: enter 12 if your sensors
scale is -20°C to +40°C and you want to have a grid line every 5°
(number=(scale_max - scale_min) / interval). Some limitations apply.

o The Band High (%)/Low (%) is the percentage of available space for this y-
axis and the chart curve. The default is 0 to 100 % (meaning that the grid
will use all available space). Band is helpful for Data view panels that
contain many similar tags (e.g. Battery voltages=BV). You can say: Use the
lower 50 % for BV 1 and the upper 50 % for BV 2. The axis and the chart
curves would not overlap, but be drawn in different parts of the grid. The
settings for BV 1 would be Low=0, High=50 and the lower half of the grid
would display these voltages. BV 2 woulfd have settings of Low=50,
High=100 and the upper half of the grid would display its voltages.

You can also experiment with these fields in conjunction with the autoscale,
autostack, and overlap features to create a variety of interesting charts.

e The autoscaling feature introduces the ability to show multiple chart curves
that overlap for multiple sensors, causing curves that can be difficult to
read. Use the Autom. stack and the Overlap percentage features to display
the curve in several different ways that eliminate any such difficulty. You
can select all of the sensors in the Settings dialog and click the Autom.
stack button to stack the values for each sensor on top of each other. In
some instances, however, you might need to show some overlap. You can
still select sensors to autostack but enter a percentage of overlap to show.

Following is an explanation of the options on the Plot tab shown in
Figure 45. Data View Settings, Plot Tab
¥ Axis | Plot | Thresholds |
e
7] visible

Style: Bar -

Color: E
Line weight:
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o The Visible checkbox has the same function as the checkbox in the legend.
If the checkbox is selected, the sensor values appear in the panel. If the
checkbox is not selected, the values do not appear.

o You can use a Line or Style for the values in the panel. You can use different
styles for plotting your data values. The style is useful for sum values, such
as precipitation or data flow: Line, Bar, or Area style

e Use the Color chooser to change the color of the Line.

o Select the Line thickness from the Weight list.

You can define multiple thresholds per tag in a Data view. A threshold is an
interesting value (range), where the chart curve “enters” or “leaves” a certain
range. For example, you can set a threshold for when a value is suddenly
outside its usual range (e.g. “only values between 0 and 10°C are valid”) or
when a certain value is met (e.g. “when value drops below 0°C").

illustrates the Thresholds tab.

Do not confuse this feature with the Threshold settings in the tag itself.

With addVANTAGE Pro 6.6, each tag, independent from the Data view, can have
thresholds. When the tag’s thresholds are met, normally an action is performed.
The Data view panel’s thresholds are only informational and thus are not the
same as the tag’s thresholds.

Figure 46. Data View Settings, Thresholds Tab
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Following is an explanation of the options on the Thresholds tab shown in

J In the Thresholds list, use the Add, Remove, Move Up, and Move Down
buttons the same way you use them for Tags. In this case, however, when
you Add a threshold, you will give it a name that has meaning for you.

. General
o Name the threshold you added. If you don’t enter a name,

addVANTAGE Pro names it something like Threshold 1.

. Enter a Value that determines where the threshold starts.

o Use the Label Color chooser to pick the color of the name or value of
the threshold displayed in the chart.

o Select the Show name on Y-Axis checkbox to display the Name of the
threshold on the grid, in the color you chose. If you do not select this
checkbox, the Value will be displayed instead.

. When you select the Always show thresholds checkbox, the threshold
always displays on the grid, no matter which sensor is selected in the
Legend. When this checkbox is not selected, the threshold displays on
the grid only when the corresponding tag is selected in the Legend.

e Use the Fill fields to determine an area that should be filled (Fill to) from
the entered Value to a Base set in the next field. You can also select Min.
Scale or Max. Scale to draw a fill box in the range between the Value and
the bottom or top of the plot.

o Use the Line fields to determine whether to Paint (draw) a line and which
color to use, as well as which line Weight (thickness) to use.
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Following is an explanation of the options on the General tab shown in

. These options apply to the Data view itself, not the individual tag

selected in the Tags list.

Sensors
Legend
Events
Map

General

Figure 47. Data View Settings, General
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e Time Axis Options

If you select the Major Grid checkbox, vertical lines will display on the
grid. The number of lines is not selectable, but it depends on the
selected time range (e.g. 7 lines when 1 Wee is selected or one line
every 4 hours when 1 Day is selected). Use the color chooser next to
the checkbox to specify the vertical line color.

The Time axis color shows the color of the time axis.

e  Duration Options

The Duration Options are the same as the duration shown in the Tool
bar. You can change the duration on this tab or in the Tool bar.

Use the Gap at end of data to specify a period of time to appear at
the end of the grid with no data, which could be useful, for example, to
show when a threshold was reached.

You can select the option Always jump to last available data
which—as the name implies—executes the “"Go to end” function every
time you open the saved panel.

The Min. start date and Max. end date can be useful if you don’t
want to show data outside this time range, e.g. when your station got
relocated but still uses the same ID.
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e  Graphic Options

o Use the Graphic Background color chooser to pick a color for the grid’s
background.

o Use the Axis background color chooser to pick the color that displays in
the background of the Y and X axes.

e  You can select the Y-Axis style as Collapsed or Expanded (=default).
The Collapsed style is also known as the “LiveData style”, where you
can see all y-axis at once, but there are only 3 values shown: min,
max and the middle of the y-axis.

o The Show seconds in panels checkbox works as described on

to determine whether seconds show in
displays of time.

o Use the Show Values at Cursor checkbox the same way you use button
Show Values at Cursor in the Tool bar. That is, if you select the
checkbox and then click the left mouse button, you see the sensor
values at that position. Furthermore, you can click and drag the mouse
to see all the values. Uncheck this checkbox for statistics on the fly.
Click and drag the mouse to select the range for calculating SUM/AVG/
MIN/MAX. The results are displayed in the legend beneath each
individual tag, such as the example shown in

Figure 48. Statistics on the fly
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o Show events in graphics shows/hides the graphic, where you can
select the event that is currently displayed. It can help to save space
when you hide it.

. Show time navigation shows/hides the time line at the bottom,
where you can select the time that is currently displayed. It can help to
save space when you hide it.
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Displaying tags from different areas/RTUs on the same Data view panel can be
very useful. For example, you could set up a panel showing the battery level for
a group of RTUs and be able to inspect or compare them at a glance, such as the
example shown in .

Figure 49. A Data View Panel Showing Tags from Several RTUs
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You can export all of the data from this Graphical view the same way as from the
Table view, which is described on .

Now that you’ve configured those tags, you might want to save this panel for
later use. If you are working with a data provider rather than your own copy of
addVANTAGE Pro 6.6, please make sure that you have the privileges to save
your changes.

When you first create a Data view or any other type of panel, you must click
Save or Save As in the Tool bar to save the panel. You typically use Save As
when you’ve made changes to an existing panel and want to save it under a
different name. In either case, the Save dialog shown in is displayed.

If you try to close an existing Data view panel, one of two things happens. If you
chose to automatically save panels when you close them (see

), the Data view panel closes with any changes you made
saved. If you did not choose to automatically save panels, a pop-up appears,
asking if you want to save the Data view panel. Click Yes to display the Save
dialog.

Select an area (a folder) where you want your custom Data view panel saved.
It's best to select an area having a certain relationship with the content of the
Data view panel, but there is no rule to prevent you from saving it directly under
the root node (except that the name must be unique in that area). Enter an
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appropriate name in the Name field, then click OK to save the customized Data
view panel.

Figure 50. Save Dialog

= ﬂ addVANTAGE Pro 6 - DEMO SERVER -
= ﬂ . Area 6.5
= ﬂ Area 6.5
+ ﬂ Adcon Klosterneuburg
== Battery
:Z Battery Diagnostic
£= Multiple Sensors of the same type
. W TEST aREa -

MName: Battery Diagnostic

OK | Cancel |

You can also save a panel any time by clicking Save in the Tool bar.

If you have to create a large number of identical panels on different areas, you
can use the Data view panel from template function and save yourself some
work:

1. Create a panel in a single area by using one of the methods previously
described, then add the tags you need and configure the panel’s settings.

2. Save the panel in its area. This will be used later as a template panel.

3. Right-click the areas where you want to save the copied Data view panels
and select New Node from template » Panel from template. A File Open
dialog is displayed.

4. Nla\f(igate to the area where you saved the template panel and select it, then
click OK.

The system creates a Data view panel with the same settings as the panel used
as the template in each area you selected. If a tag does not exist in the
respective area, a placeholder for it is included in the panel, and you can choose
to import data from another RTU that does have the tag. The new panels will
borrow the name of the original panel used as the template. If a panel with this
name already exists in an area, the newly created panel will have a running
number appended, for example, Weather (2).

Note: The term “template” is used only for better understanding the concept of
creating panels from existing panels. Any panel can be used as a template.You
can also right-click a Data view panel and use the Copy, and Paste &
Reconnect options.
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To switch from a Graphical view to a tabular view of data, click the Table view
button previously described, see "Table view ).

While the Tool bar remains the same, your chart lines will disappear and every
value of the time span you selected will appear as a table, as shown in

. Please note that this usually requires several screens, since a single
day of 15-minute data already consists of 96 entries. You can therefore navigate
back and forth in time by either clicking the page number or the navigation
arrows on the bottom left of the table viewer.

Figure 51. Table View
BES (2RE R e o « TP~ - e - AT B E o P

Date | Battery voltage| [l Batt Adcon Kibg | [ll Battery voltage | [l Battery Voltage | [l Battery voltage | | Battery voltage | [}l Battery Voltage
0ct 5, 2016 7:00:00 643V 5.96V 7.14V 6.35V 6.59V 5.96V 6.82V
Oct 5, 2016 7:05:00 7.4V 6.59V
0ct 5, 2016 7:10:00 6.43V 714V 6.59V
Oct 5, 2016 7:15:00 5.96V 7.4V 6.35V 6.59V 5.96V 6.82V
Oct 5, 2016 7:20:00 6.43V 714V 6.59V
Oct 5, 2016 7:25:00 7.4V 6.59V
0ct 5, 2016 7:30:00 6.43V 6.04V 714V 6.35V 6.59V 6.04V 690V
Oct 5, 2016 7:35:00 7.4V 6.67V
0ct 5, 2016 7:40:00 6.43V 714V 6.67V
Oct 5, 2016 7:45:00 612V 7.06V 6.35V 6.67V 612V 6.98V
0ct 5, 2016 7:50:00 6.43V 7.06V 6.67V
Oct 5, 2016 7:55:00 7.06V 6.67V

[# 4 <311 311312 313 314 315 316 317 318 319 320 »320 = =

‘Copyright © 2001-2016 Adcon Telemetry. Al rights reserved. Administrator manual
Note: You can click the Graphical view button to return to the plot display.
Note: You can now edit data in the Table view. One way to do this is to double-click a

value in the table, type what you want the value to be, and press the Enter key.
The value displays in the table and the cell is highlighted in red. If you change
your mind, you can right-click in the cell and select Remove manual values.

If you want to add values to the table, right-click in the table and select Add new
values to display the dialog shown in .

Figure 52. Adding a Value in the Table View

Tag: Battery Voltage -
Timestamp: October 5, 2016 [3 07:15 %
Duration: 15 minutes
Value: | v
Add... | Close |

Once you have manually recorded values in additions to the existing values, you
can add them to the table by following these steps:

1. Select the Tag from the drop-down.

(ij ¥ou|tright-clicked a column in the Table view, that tag is displayed by
efault.

2. Select the date and time (Timestamp) for the first new value.

3. The Duration defaults to the recording interval for the selected tag’s values.
Change this duration if needed.

4. Enter the Value and click Add.

The dialog remains, but the timestamp moves to the interval shown in the

Duration field.

Enter any other new values, clicking Add each time.

6. When you've entered all the values, click Close.
The table will redisplay with the manual values you‘ve just entered
highlighted in red.

Note: If you entered values that already existed for the timestamp you selected, they
will overwrite the table’s values as manual entries.

v
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While viewing data in the Table view you can easily export all or part of it into an
ASCII format file. In the Graphical view, you can export only all of the data.

Method 1: Exporting selected data sets via Date and Span Chooser (copy to csv)

1. Right-click in the body of the table.

2. Choose Export all values in selected time range from the menu that
appears.

3. Depending on your browser, you can open and/or save the file on your
computer. The default name of this file is values. csv, which you should
replace with a more meaningful name.

4. You can now open this file with spreadsheet software such as Excel or
00o.Calc

Figure 53. Export All Data from Table View
B2 REB|e oo « TSI - b b c» + T B E = B

Date | Battery voltage | Il Batt Adcon Kibg | Il Battery Voltage | Il Battery Voltage | Ml Battery Voltage | | Battery Voltage | Il Battery voltage

Oct 5, 2016 8:40:00 £ Ray £.90 V 6.67V
A5 Copy selected values to clipboard -
Oct 5, 2016 B:45: Py P 7.4V L =
Oct 5, 2016 8:50: Export all values in selected time range... 7.14V
Oct 5, 2016 B:55: 7.14V Sie machten folgende Datei Gffnen:
Oct 5, 2016 9:00:  Add new values 6.98V ) valu
Oct 5, 2016 9:05: Remove manual values 7.14V
Vom Typ:
Oct 5, 2016 9:10: 714V VDm hyp jl\j;crosoftdﬁccal Comma Separated Values File
on: http:, B .at
Oct 5, 2016 9:15: B manual event... 7.14V [REG SRRt
Oct 5, 2016 9:20: 7.14V ‘Wie soll Firefox mit dieser Datei verfahren?
Oct 5, 2016 9:25: = Settings... 7.14V 5 Gif = = P
@ it t M

Oct 5, 2016 9:30:00 6.75V 6.59 ¥ 7.14Y ® Offnen mit | b teeplEseel Dlandan)
Oct 5, 2016 9:35:00 7.14V () Datei speichern
QOct 5, 2016 9:40:00 6.82V 7.4V

[ Fir Dateien dieses Typs immer diese Aktion ausfihren

[ 4 <291 291 292 293 294 295 296 297 298 =» =

0K Abbrechen

Only the data you defined in the Date and Span Chooser will be exported (with
the start date as shown in the calendar, and the amount of data as shown in the
Span area), even if the register cannot display all entries on a page, or if you
have scrolled forwards or back in the register.

‘Copyright © 2001-2016 Adcon Telemetry. All rights reserved.

Look at the example above. What we export in is the data as can be
seen: 2 weeks (Span chooser), beginning on September 22, 2016 (Date
Chooser).

Should you want to export all the data of a selected chart, you need to (the Data
view Tool bar is shown in ):

o Set the start date to the beginning of the database (Go to Begin)

. Select Custom in the Span Chooser, then select a reasonable duration.

Method 2: Exporting selected data sets only (copy to clipboard)

If you want to export only a few lines of data from the current screen, you can
copy them to the clipboard.

1. Select data you want to copy (Ctrl+Click as shown in
2. Right-click in the body of the table and select Copy selected values to
clipboard from the menu that appears.
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3. Open a text editor or spreadsheet program such as Excel or OOo.Calc and
paste the contents of the clipboard.

Figure 54. Copying Selected Data into the Clipboard
Tl "'l 2 & ‘ [ 4t o o . _SeptemberZZ,ZMG - Ly _ZWeeks M ‘J B Kl

Date | M sattery voltage| [l Batt Adcon Kibg | [l Battery Voltage | Il Battery voltage | [}l Battery Voltage | | Battery voltage | [}l Battery voltage
Oct 5, 2016 8:40:00 £.5a3 6.90V 6.67V
Oct 5, 2016 8:45: Copy selectad values to clipboard 7.14V e ‘ ] |
Qct 5, 2016 8:50: Export all values in selacted time range... 7.14V
Oct 5, 2016 8:55: 7.14V Sie michten folgende Datei Gffnen:
Oct 5, 2016 9:00: Add new values 6.98V 5] values.csv
Oct 5, 2016 9:05: Remove manual values 7.14V
Oct 5, 2016 9:10: 714V ::: Th}:':;.;fl;cezzo:tdizc:lafomma Separated Values File
Oct 5, 2016 9:15: @ Manual event... 7.14V i : i
Oct 5, 2016 9:20: 7.14V ‘Wie soll Firefox mit dieser Datei verfahren?
Ot 169207 B Settings... LAY @ Offnen mit | Microsoft Excel (Standard) -
Oct 5, 2016 9:30:00 6.75V 6.59V 7.14V C
Oct 5, 2016 9:35:00 7.14V () Datei gpeichern
Oct 5, 2016 9:40:00 6.82V 7.14V

[ Fir Dateien dieses Typs immer diese Aktion ausfihren

[ 4= <291 291 292 293 294 295 296 297 298 = =

0K Abbrechen

Copyright © 2001-2016 Adcon Telemetry. Al rights reserved.

Instrument View

If you click the Virtual Instruments button, you can view chart data in one other
view (Figure 55), similar to what you might see on an instrument panel.

Figure 55. Data View Using Virtual Instruments

BB ARG R e e

. Battery Volta... . Batt Adcon Kib... . Battery Voltag... . Battery Voltag... . Battery Voltag... Battery Voltag... . Battery Voltag..
510 s o 20 % 7% % 7% 250 % 750 g s 510 s
o = o = ) 10 o 0 o 10 ) 2 o 2
- \ - - \ + - / > - / - * / - - \ - - \ -
698V 6.82V 714V 7.06 Vv 690V 6.82V rav
Oct 5, 2016 10:30:00 AM Oct 5, 2016 10:30:00 AM Oct 5, 2016 10:45:00 AM Oct 5, 2016 10:30:00 AM Oct 5, 2016 10:15:00 AM Oct 5, 2016 10:30:00 AM Oct 5, 2016 10:15:0C

Events View
Use the Events view to see the events generated by nodes.

You'll notice that the Tool bar is very similar to the Table view’s tool bar. You are
not able to print the Events view directly, but you can click Export all values in
time range to PDF to export the table values to a PDF file. The other buttons up
through the time span chooser are identical. The differences after the span
chooser are that the Events view has an Acknowledge button.
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The Events view has extensive configuration possibilities to help you display the
events and alarms in the most appropriate way for your needs. In an active
Events view, click in the Tool bar Show Settings to display the dialog shown in

Use the Nodes tab ( ) to select the nodes whose events you want to
display. It is the second tab in the Settings dialog, but you must select a node
before you can select the event types to display alarms for. With addVANTAGE
Pro 6.6, all nodes can issue events. The selected nodes are not necessarily those
that are used to plot the chart in the Graphical view.

Figure 56. Events Options Dialog, Nodes Tab

Sensors Event Types | Nodes | Events Options |
Legend /addVANTAGE Pro 6 - DEMO SERVER
Events
Map
General
¥| Also show events from child nodes
OK | Cancel | Apply |
o Click the Add button to display the Nodes Chooser ( ), which you

use to add nodes whose events you want to view. You can select the root or
expand it to select areas.

Figure 57. The Nodes Chooser

= .1 addVANTAGE Pro 6 - DEMO SERVER (41)
=, . Area 6.6 (20135)
=l Area 6.6 (20137)
= .1 Adcon Klosterneuburg (20138)
L5 Adcon Klosterneuburg (20139)
+ & Apple 2016 (20163)
=& Banana 2016 (20188)
=@ psv (20189)
< Accum. Index (20191)
~| Daily index (20190)

e To remove a node from the Events viewer, select it on the Nodes tab and
click the Delete button.

. Use the Also show events from child nodes checkbox to see alarms/events
from nodes belonging to the node you selected.
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Another way to create an Events view is to select the nodes whose events you
want to see from the Explorer, then right-click and select Show only events.
Click Settings in the viewer to see the dialogs discussed here.

The Event Types tab ( ) displays all of the types of events that can issue
an alarm or event. If the tab is blank, you have not selected any nodes (see

).

You can scroll down in the list to see that all events are selected by default. If
you do not want a specific event to display in the Events view, unselect it in the
list. Use the Events checkbox to select or unselect all events at once.

Figure 58. Events Options Dialog, Event Types Tab

Sensors

! Event Types | Nodes | Events Options |
Legend =[] Events
= Device events
Mew version number
Station restarted
Subclass changed
= Mode events
Action failed
Action succeeded
[ Manual event
= Tag events
Can't reconnect
Data delay
Engineering unit changed
Remote ID missing
Sensor removed
Subelass changed
Threshold reached

Events
Map

General

—Severity
/| show alarms
Show events

Show service logs

—Event filter

Show only active

Only not acknowledged events

OK I Cancel | Apply I

The Event Types tab has several options for viewing events.
First, you can select which types of events to view in the Severity section:

o Show alarms displays alarms.
o Show events displays events.

o Show service logs displays messages from the system or from
administrators, such as when an RTU has been replaced.

You can also use the Event filter section to further customize the Event list. For
example:

o Show only active displays only active alarms/events, depending on your
choices for the next checkbox. If you leave this checkbox unselected, all
alarms/events for the selected span will be displayed in the Events viewer.
“Active” is defined as an alarm/event whose end date has not been reached
or is unknown.

o Only not acknowledged events allows you to display only those messages
you have not set as acknowledged.
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The Events Options tab ( ) has customization options for the data to be
displayed in the viewer.

Figure 59. Events Options Dialog, Events Options Tab

Event Type | Nodes | Events Options

Columns

+ acknowledge |/ Begin Date

End Date | Duration
4| Soures 4| Area
+ Camments

o In the Columns section, each checkbox represents a column. Select the
columns you want to see in the view.

Click OK when you are finished. The Event list ( ) shows the events you
selected.

Figure 60. Event List

HES 2 RS B e . September 22, 2016 M SMFSRFSETSCEN 2 weeks - NI~ ===l *) R A
| Begin Date v. \ Duration & \ Source & \ Area s | Comments & Ack selected alarms
[ oct 3, 2016 3:00:00 A 1d Battery charging Adcon Weather Test R Battery - ID #3867 - The daily amplitude of charge is too high ~ Unack selected alarms

[F sep 21, 2016 3:00:00 AM 1d Battery charging Adcon Weather Test R__ Battery - ID #13867 - The daily amplitude of charge is too high
[ Jun 28, 2016 6:3 PM - active - Battery Voltage Austria - Muckendorf  There is a data delay on this tag! Ack all alarms
[T Jun 8, 2016 3:00:00 AM  11%d Battery charging Adcon Weather Test R... Battery - ID #13867 - Solar panel - Data is out of the defined r{

Unack all alarms

(1] Acknowledge Acknowledges a specific alarm.
checkbox

(2] Acknowledge Acknowledges selected alarms (multiple selection) or all
button alarms.

If no events are displayed, check the date and use the arrows and the calendar
to move to a date and time where you have data.

By default, alarms are shown in red. If you click the Acknowledge checkbox or
button, they turn blue or green, which means that the alarms have been
acknowledged. Green means that the condition for the alarm is no longer
present. Blue means that the condition for the alarm still exists.

If an extension issued an alarm, an alarm icon will be shown in the Explorer
window by that extension ( ), and the alarm icon will also be shown
next to all the parent areas (folders) where the extension resides. Therefore,
while it's the statistic extension that has an alarm, the Hop crop and the Dimi
area folder also show the alarm icon.

Figure 61. Alarm Icons in the Explorer

wom 2 |~ I S

addVANTAGE Pro 6 - DEMO SERVER (41)

Adcon Klosterneuburg (20138)
Adcon Klosterneuburg (20139)
Apple 2016 (20163)
=-(. Banana 2016 (20188)
@ psv (20189)
e
ETc (20196)
Generic Model for Downy (20192)

#

[+

]
+
+

M ¥

If you notice in an Explorer that an area shows an alarm, you can right-click the
node and select Show only events. An Event list properly configured for you is
displayed, showing only the alarms pertinent to the selected object.
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Right-click an event in an Event list to see the Context menu shown in

Figure 62. Event List, Context Menu

i

M|

L

P

B2

Manual event...
Irrigation
Treatments

Show only data
Explore from here

Hide this event type

Change climate settings

Change start date of extension
Export all values in time range to PDF

Settings...

You have several options for working with the events:

Select Manual Event to manually add an event.
If you selected a crop event, you can add Irrigation or Treatments to the

crop.

Select Show only data to open an event in the Graphical view.

Click Explore from here to an Explorer showing where the event originated.
Use Hide this event type to hide all events similar to the one you selected in
the Events viewer. Show the event type again by going to the Event Types
tab, clicking Select All, and clicking OK.
If appropriate for the event, you can Change climate settings, Change
settings of extension, or Change start date of extension from this Context

menu.

Use Export all values in time range to PDF to view the events in a table in a

PDF document.

Select Settings to open the same Settings dialog as when you select
Settings in the Event List's Settings dialog.



As with previous versions, the addVANTAGE Pro 6.6 software has extended
functionality through additional software modules called extensions. Extensions
are entities that perform calculations.

The types of extensions you work with are calculation extensions and disease
models. Crops are nodes that store information about phenophases, irrigations,
and treatments. They are not extensions. Disease models are extensions that
apply only to crops. They receive events issued by the crop. Calculation
extensions usually apply to an area. Although they can be children of a crop
node, calculation extensions do not receive events issued by the crop (such as
when a treatment is applied).

Another set of extensions now available is called RTU diagnostics. These
diagnostic extensions are associated with RTU tags and they verify whether the
data coming from a tag is plausible (see ).

You can right-click any extension or crop and use the Copy, and Paste &
Reconnect options to duplicate the extension or crop in another part of the
Explorer.

Some extensions are included with the software and others can be installed
separately. For example, Adcon Telemetry provides a collection of calculation
extensions and disease models (still collectively known as extensions) in a
package you can receive free of charge. Additional extensions—as addTIMER,
BEE, Maryblight—are available and may be purchased. These extensions are
documented in a separate addVANTAGE Pro Extensions and Crops manual. For
this manual and the extensions please contact Adcon Telemetry or your Adcon
Distributor.
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You will also find that certain calculation extensions and disease models have
additional information available in the software itself, on their Settings dialog’s
Extension tab.

Figure 63. Info Button for Apply Powdery Mildew (Kast OiDiag) Extension
General | Extension | Inputs | Action | Security |

Algorithm variables

Crop: Sensitive

Used method to start the index calculation: @ 0

@ Phenological stage
| Last year severity

OK | Cancel | Apply I
(1] Info button Opens a dialog with additional information about using the
extension.

Extensions will automatically recalculated if their options have been changed.
This operation usually takes only a couple of seconds, but in extreme cases
(large data sets or many extensions running in parallel) it can take up to several
minutes. The settings in the Crops, Treatments, Inputs, Irrigation and
Extension tabs may force a recalculation if changed. You can also force a
recalculation of one or more extensions by selecting the respective extension in
the Explorer, right-clicking, and selecting Recalculate.

Extensions can be added to areas and crops, while crops can be added only to
areas. To add either, follow these steps:

1. Open an Explorer.

2. Select where you want the extension or crop added (use the Shift or the
Ctrl key if you're selecting multiple locations).

3. Right-click the highlighted areas and select New Node » Calculation
extension » extension or New Node » Crops » crop.

The extension or crop is added to the area in the Explorer, where you can
configure it as needed. When you add a crop, all of the disease models of the
crop are created by default.

You can add multiple extensions and crops to the same area and create different
settings for each. Subsequent extensions and crops in the same area take the
name of the first, but with a number appended (for example, Apple [1] or
Running Total [1]).

You can also edit multiple extensions and crops. Use Ctrl+Click to select the
nodes, then click Settings. If the selected extensions are not identical, only their
common settings will be displayed.
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You can add an extension or crop by creating it from a template, that is, from an
existing extension or crop.

1. Add the extension or crop in a single area using one of the methods
described above and set up its settings as you want to.

2. Right-click the selected areas where you want a copy of the extension or
crop and select New Node from template » Calculation extension or New
Node from template » Crops. A File Open dialog displays.

3. Navigate to the area where you saved the template panel and select it, then
click OK.

The system creates the extension or crop with the same settings as the one
used as the template in each area you selected. All child extensions will be
created.

You can also install extensions and crops using node template by right-clicking
an areas and selecting New Node from template » Using node templates. Select
the appropriate template and click Finish to add the extension or crop.

In a way that is similar to creating a crop by template, you can start a new
season of a crop. This procedure is probably more useful for the previous year’s
crops because it copies the crop settings but uses current dates.

1. In the Explorer, right-click the crop you want to copy for the new season
and select New Node from template » Start new season.
2. Update the new crop’s settings or move it to another area as needed.

For automatically checking sensor values attach the RTU Diagnostics to the
sensor. The data coming from the sensors or tags is then checked for plausible
values. The detection of problems is based on typical patterns which are
associated with defective sensors.

These patterns could be for example:
o Missing data

o Constant values detection

o Drop detection

o Shadow detection

o WMO equations

o and many more

Adding RTU Diagnostics to a Tag
To add these diagnostic extensions, follow these steps:

1. Open an Explorer.

2. Select the sensor where you want to add the diagnostic extension (use the
Shift or the Ctrl key if you are selecting multiple sensors).

3. Right-click the highlighted areas and select New Node » RTU
diagnostics » Extension.
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You can also select New Node » RTU diagnostics » Create all missing. If you
choose this option, all available diagnostic extensions for the selected tag(s) or
sensor(s) are installed (shown in ):

Figure 64. Plausibility Extension

ADC®N addVANTAGE Pro 6.6

TELEMETRY The next level of visualisation

Tools | Window | Help | Logout :

o om | » I

=5 -'.1 addVANTAGE Pro 6 - DEMO SERVER (41)
. Area 6.6 (20135)
- .. TEST AREA (4550)

= PLAYGROUND - will be deleted every 1st day of a month (66)
W (i77sg
- 51297 - Farmers National/HHD - Pivot AMR (17336)
- Bill's Apple Yard in the us (4681)

Bill's vinyard (4776)

Ciprian (10968)

Farmer Johns Weather Station (14657)
= Klosterneuburg (5224)
E| ﬂ 8020 addIT Weather RTU (5234)
B 1 8020 addIT Weather RTU (5235)
Battery Voltage (5243)
Data Delay (5238)
Incoming RF Level (5245)
L internal Temperature (5241)
@), Leaf Wetness (5236)
[ outgoing RF Level (5245)

% Precipitation (5250)

Pyranometer CM3 (5244)
Radio Error Rate (long-term) (5237)

=2 Radio Error Rate (sha  New node v £ RTU diagnostics » §? constant value detaction
% Relative Humidity (52 o) node from template » [ calculation extension + §2- Drop Detection

Solar Cell (5248)
Temperature (5239) | . show only data
"% Wind Direction (5242
- f » Wind Speed (5240)
. Conditions (20110)

-2 MERA Test Panel (10446]

Meteorological extension  » P2 Missing data

[} Water-Irrigation extension » P2 Range

Show only events . .
& Y # . Export extension r 2 wmo equations (TEMP)

5 Manual event... Create all missing

~EZ Wetterdaten (5251) Connact

KNOTS (19744) Reload data...

Lake Victoria Area (10315) Change values manually
Test SV (12940) 3 Delete

XYZ Farms[farm] (10186)
m .Recycling bin - will be cleaned mor ﬂ Explore from here
Agricultural disease management ( _1 Search from here. .
Agriculture Demo (4813)

Coffe-Banana Demo [17485}

= Settings...

The Plausibility Extension is based on the Képpen-Geiger climate classification, a
set of basic climate parameters, which can be adapted to your specific needs.
You can access the Climate manager via the Tool bar Tools » Climate Manager to
modify the algorithm variables. Your ability to edit this dialog depends on your
user role.
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Some extensions and crops must be configured. To display the settings
( ), highlight the extension or crop in the Explorer and click the Settings

button in the Tool bar.

Figure 65. Statistics Extension Settings Dialog, General Tab

General | Extension | Inputs | Action | Security

Temperature Statistic

Location:

Class:
Subclass:
Node 1D:
Alarms:
Events:
Service logs:

Last calculation
performed at:

Time zone:

@ Enabled
Disabled

faddVANTAGE Pro 6 - DEMO SERVER/. Area 6.5/Area 6.5/Adcon
Klosterneuburg/ Temperature Statistic

EXTENSION

statistic

20159

0 total, 0 acknowledged.
0 total, 0 acknowledged.
0 total, 0 acknowledged.

Oct 19, 2016 11:59:00 PM

Europe/Vienna

OK

Cancel Apply

shows the settings specific to the Statistics calculation extension.

The General tab displays general information about the extension/crop, and for
calculation extensions and disease models, allows you to enable or disable
individual extensions. If you look closely at the extension’s icon, you can tell
whether the extension is enabled or disabled.

The green triangle in
the bottom left corner
indicates the extension
is enabled.

> The gray square in the .

bottom left corner
indicates the
extension is disabled.

If an extension is being executed, the green triangle appears to move
across the bottom of the icon.

The Action and Security tabs are discussed in
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Three additional tabs pertain to crops.

Use the Crop tab ( ) to specify and monitor the phenological stages of
crops.

Figure 66. Crop Settings, Crop Tab

General | Crop | Treatments | Irrigation | Action | Security |

BBCH | Name | Date | |
00 Recently planted material Jan 1, 2016
10 Formation of the 1st leaf Jan 11, 2016
29 Mine or more suckers Mar 18, 2016

35 The pseudostem reaches 50 ... Apr 25, 2016
55 Flower bract completely open  May 10, 2016
65 Full bloom: at least 50 % of t.. Jun 4, 2016

72 The fingers of the hands sho... Jun 29, 2016
85 Degree of maturity 5: tinge o... Oct 27, 2016

OK | Cancel | Apply |

Note: Clicking a phase causes a graphic depiction of the phase to be displayed on the
right side of the dialog, if such a graphic is available.

Changing Dates for Phenological Phases

In principle, the system can be installed anytime, but starting it at the beginning
of the growing season has certain advantages. The software uses a calendar
year with the appropriate phase dates set, but you can change these dates. Do
this by using the Crops panel, which sets the proper phenological phase.

To set the season or phase starting date, complete the following steps

( ):

1 Right-click the crop and select Settings.
2. Click the Crop tab.
3. Select the desired phase in the Name column.
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4. Click the Calendar icon and select the date for the phase to begin, then click
Apply.
Figure 67. Setting a Phase’s Start Date

General | Crop | Treatments | Irrigation | Action | Security |

BBCH | Name | Date /|
00 Recently planted material Jan 1, 2016
10 Formation of the 1st leaf Jan 11, 2016
29 Mine or more suckers Mar 18, 2016

35 The pseudostem reaches 50 % .. Apr 25, 2016
55 Flower bract completely open May 10, 2016
65 Full bloom: at least 50 % of th.. Jun 4, 2016
72 The fingers of the hands show... Jun 29, 2016
85 Degree of maturity

‘Mon Tue Wed Thu Fri Sat Sun

1 2 3 4 5

[] 7 8 g 10| 11| 12

13| 14 | 15 [ 16 | 17 | 18 [ 19

0| M| 2223 4| 25| 26

T | 8| 29 | 30

OK | Cancel | Apply |

Generally, the first phenological phase corresponds with the year’s begin in the
northern hemisphere, that is the 1st of January. After you set the date for a
phase, dates for subsequent phases are automatically computed from the
defaults programmed for each crop.

Climatic conditions during certain seasons could differ from the pre-programmed
defaults, so Adcon recommends that you verify at regular intervals whether the
model is in synchronicity with the field conditions. If this is not the case, use the
method described above to change each individual phase’s date accordingly.
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Use the Treatments tab ( ) to inform the crop that a chemical treatment
was applied.

If the chemical you want to apply is not in the system’s database, you must first
add it. For more details about adding to or modifying the chemicals database,
refer to the addVANTAGE Pro Extensions and Crops manual.

Figure 68. Crop Settings, Treatments Tab
General | Crop | Treatments | Irrigation | Action | Security |

Application date « | Chemical ¢ | Remark ¢
Oct 20, 2016 10:14:00 AM  BANANA - SYSTEMIC - .

OK | Cancel Apply

Adding Treatments

A spraying application usually follows a treatment recommendation (displayed in
the Events list). To inform the model you applied a field treatment, do the
following ( ):

1. Right-click the crop and select Settings.
2. Click the Treatments tab, then the Add icon.

Figure 69. Applying a Treatment

Chemical: Warning ignored (DSV) -
Application o 50 2016 10:18 AM Europe/Vienna
date:
Remark:

|

| OK | Cancel |

3. Select the chemical you applied in the field from the list.

4. In the Application date field, click the Calendar icon to select the correct
treatment date and time from the pop-up that appears.

Note: The wording shown to the right of the Calendar icon indicates the server’s
location.

5. Enter a Remark (optional).
6. Press OK when you are done.

Note: A treatment is made at the crop level so if for example the chemical used is valid
for powdery and downy mildew a treatment made at the crop level will go for
those two diseases.

If you decide that you don’t need to apply a treatment, e.g. if other
circumstances determine a treatment is not warranted, you must select the
entry "Warning ignored” from the chemicals list. Whatever the case is, you must
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either apply a treatment or choose to ignore the warning. Failure to do so will
leave the current alarm active and no new warnings will be issued.
Removing a Treatment

If you added a treatment and you find out at a later date that it was incorrect
(either the date of application, or the type of chemical), you can delete the
treatment and add the correct one, if needed. Proceed as follows:

1. Right-click the crop and select Settings.

2. Click the Treatments tab.

3. Select the treatment from the lower list and click the Remove icon.
4. Click the OK button.

The system automatically recalculates the model’s new data.

Use the Irrigation tab ( ) to create irrigation schedules for the crop.

Figure 70. Crop Settings, Irrigation Tab

General | Crop | Treatments | Irrigation | Action | Security |

Application date « | Duration ¢ | Quantity ¢ Remark ¢
Oct 18, 2016 11:30:00 AM 1d 3.0 mm initial irrigation
¥
OK | Cancel | Apply |

Adding an Irrigation Schedule

When you add an irrigation schedule, you are telling the model what type of
irrigation, how long the irrigation occurs, and how much irrigation the crop gets
( ). Follow these steps to add this schedule:

1. Right-click the crop and select Settings.
2. Click the Irrigation tab, then the Add icon.

Figure 71. Adding Irrigation

Irrigation

e Sprinkler -

Application  Oct 20, 2016 10:22 AM

date: Europe/Vienna

Duration: 1d h m

Quantity: 0 mm

Remark:

OK | Cancel

L_—

3. Select the Irrigation Type.
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4. In the Application date field, click the Calendar icon to select the correct
treatment date and time from the pop-up that appears.

Note: The wording shown to the right of the Calendar icon indicates the server’s
location.

5. In the Duration field, enter how long the irrigation lasted, in days, hours,
and/or minutes.

6. In the Quantity field, enter how much water was sent to the crop.

7. Enter a Remark. (optional)

8. Press OK when you are done.

Removing an Irrigation Schedule

If you added an irrigation and you find out at a later date that it was incorrect,
you can delete the treatment and add the correct one, if needed. Proceed as
follows:

1. Right-click the crop and select Settings.
2. Click the Irrigation tab.

3. Select the appropriate irrigation schedule from the lower list and click the
Remove icon.

4. Click the OK button.

Calculation extensions and disease models have tabs that are different from the
ones for crops.

Most calculation extensions have an Extension tab, as shown in
Figure 72. Statistic Extension Settings, Extension Tab
General | Extension | Advanced settings | Inputs | Action | Security |

Schedule

Begin date: Time zone: CET
End data: Time zone: CET
gegin time: | 23[z]:|  59[]

Scheduling

Calculate one value per 1@ Dayl(s) -
Use values of the last 1[Z] pavis) =

Computations

Minimum

iax imurm

[Min + Max) £ 2
Average

Sum

Circular average

OK | Cancel | Apply |

The Extension tab contains options and configuration panels that are specific to
the extension.



addVANTAGE Pro 6.6 User Manual CHAPTER 5

Settings for Extensions and Crops

The Advanced settings tab ( ) provides additional information about the
extension options.

Figure 73. Statistic Extension Settings, Advanced Settings Tab

General | Extension | Advanced settings | Inputs | Action | Security |

Name | Type | value | Unit
AVEG Boclean false
MAX Boolean false
MID Boolean false
MIN Boolean false
SUM Boolean false
CAVG Boclean false

Resetio default

OK Cancel | Apply

Note: Note that your ability to see the Advanced Settings tab is determined by your
user role and a setting in the Tools menu.

The Inputs tab ( ) allows you to set the input tags for the extension.
The extensions have an intelligent algorithm that searches for the appropriate
tags, but only within the extension’s own area.

Figure 74. Extension Settings Dialog, Inputs Tab

General | Extension | Inputs | Action | Security |

. Leafwetness
& Relative Humidity
:1 Temperature

Add...

J| Adcon Klosterneuburg/ Temperature
Temperature Statistic/ Temperature (AVG)
Temperature Statistic/ Temperature (MAX)
Temperature Statistic/ Temperature (MIN)

OK Cancel Apply

Adding Inputs

If some tags are missing and the auto discovery feature fails, you should
manually intervene to identify the required tags. If multiple tags of the same
type exist on a given area, you will have to manually select which tag type you
want. You can also choose tags from other areas if you need the same type of

tag in more than one area, or if the application can be used with tags from other
areas.

For more details about calculation extensions and disease models, please
consult the addVANTAGE Pro Extensions and Crops manual.
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Although the Diagnostic Extensions have the same settings as calculation
extensions, the Extensions tab has some differences, as you can see in

Figure 75. Diagnostic Extension Settings, Extensions Tab

General | Extension | Inputs | Action | Security |

Schedule

Begin date: V| |Mar 21, 2014 Time zone: CET
End date: Time zone: CET
Begin time: 2|Z|: 0|Z|

Climate

J| Use climate settings
Warm temperature - winter dry - hot summer -

Located in the northern hemisphere:

Algorithm variables

Acceptable percentage of missing or bad data: 2.0|%

Event

Severity: Alarm

Show ID of the sensor in the events:

OK | Cancel | Apply |

RTU diagnostics are tied to the 30 climate options you can choose from. Your
climate was most likely selected for you when you installed the RTU and is based
on your GPS location, although you can select a different climate. Climate
characteristics are controlled through the Climate manager—see

The settings shown in are for a Missing Data diagnostic extension of a
temperature sensor. Either you choose one of the supplied climate settings by
using the checkbox, or you use your own Algorithm variable and Event settings.
The Schedule settings are the same as for calculation extensions.



This appendix contains information concerning third-party tools Adcon employs.

The following tools are used in the addVANTAGE Pro Project. You can find the
actual license agreement for each tool in our separate addVANTAGE Pro Third-
Party License Agreements document.

ant.jar

Version 1.6.2

http://ant.apache.org

Apache License Version 2.0, January 2004

antlr-2.7.6.jar
Version 2.7.6
http://www.antlr.org/

commons-beanutils.jar

Version 1.7
http://jakarta.apache.org/commons/beanutils/
The Apache Software License, Version 1.1

commons-codec-1.3.jar

Version 1.3
http://jakarta.apache.org/commons/codec/
Apache License Version 2.0, January 2004

commons-collections-3.1.jar

Version 3.1
http://jakarta.apache.org/commons/collections/
Apache License Version 2.0, January 2004

commons-compress-1.4.1.jar

Version 1.4.1
http://commons.apache.org/proper/commons-compress/
Apache License Version 2.0, January 2004

commons-digester.jar

Version 1.8
http://jakarta.apache.org/commons/digester/
The Apache Software License, Version 1.1

commons-discovery-0.4.jar

Version 0.4
http://commons.apache.org/discovery/
Apache License Version 2.0, January 2004

commons-fileupload-1.3.jar

Version 1.3
http://commons.apache.org/proper/commons-fileupload/
Apache License Version 2.0, January 2004

commons-io-2.4.jar

Version 2.4
http://commons.apache.org/proper/commons-io/
Apache License Version 2.0, January 2004
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commons-logging.jar

Version 1.0.4
http://jakarta.apache.org/commons/logging/
Apache License Version 2.0, January 2004

commons-logging-api.jar

Version 1.0.4
http://jakarta.apache.org/commons/logging/
Apache License Version 2.0, January 2004

commons-net-3.1.jar

Version 3.1
http://commons.apache.org/proper/commons-net/
Apache License Version 2.0, January 2004

commons-validator.jar

Version 1.1.3
http://jakarta.apache.org/commons/validator/
Apache License Version 2.0, January 2004

datetimepicker2.7.jar

Version 2.7
http://www.lavantech.com/datetimepicker/
Bought - http://www.lavantech.com/license.shtml

dom4j-1.6.1.jar
Version 1.6.1
http://www.dom4j.org/
BSD License

ehcache-1.5.0.jar

Version 1.5.0

http://ehcache.org/

Apache License Version 2.0, January 2004

ejb3-persistence.jar
Version 3.0 FR (1.0.1.GA)
basically MIT

gmaps4jsf-1.1.3-u3.jar

Version 1.1.3
http://code.google.com/p/gmaps4jsf/
Apache License Version 2.0, January 2004

gson-2.2.2.jar

Version 2.2.2
http://code.google.com/p/google-gson/
Apache License Version 2.0, January 2004

hibernate-annotations.jar
Version 3.4.0.GA
http://annotations.hibernate.org
LGPL

hibernate-commons-annotations.jar
Version 3.1.0.GA
http://annotations.hibernate.org
LGPL

hibernate3.jar

Version 3.4.0.GA
https://sourceforge.net/projects/hibernate/
LGPL

hibernate-entitymanager.jar

Version 3.4.0.GA
https://www.hibernate.org/397.html
LGPL
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hsqldb.jar

Adcon-Version
http://hsqldb.org/

LGPL (Version 3, June 2007)

iText-2.0.7.jar

Version 2.0.7

http://itextpdf.com/

LGPL (Version 2.1, February 1999)

jaas.jar
http://java.sun.com/javase/technologies/security/
Sun binary code license

javamelody-1.25.0.jar

Version 1.25.0
http://code.google.com/p/javamelody/
LGPL (Version 3, June 2007)

javassist-3.4.GA.jar

Version 3.4.GA
http://www.csg.is.titech.ac.jp/~chiba/javassist/
LGPL

javasysmon-0.3.4.jar

Version 0.3.4
https://github.com/jezhumble/javasysmon
NetBSD (2-line) license

jaxen-1.1.1.jar
Version 1.1.1
http://jaxen.org/
Apache style, Attached

jcommon-1.0.10.jar

Version 1.0.10
http://www.jfree.org/jfreechart/
LGPL (Version 3, June 2007)

jfreechart-1.1.1_adcon.jar
Version 1.1_adcon
http://www.jfree.org/jfreechart/
LGPL (Version 3, June 2007)

jmf.jar
http://java.sun.com/products/java-media/jmf/
JMF License

jsf-api-1.2_04-p02.jar

Version 1.2_04-b16-p02
http://java.sun.com/javaee/javaserverfaces/reference/api/
CDDL (parts Apache)

jsf-facelets.jar

Version 1.1.14
https://facelets.dev.java.net/

Apache License Version 2.0, January 2004

jRegistryKey.jar

Version 1.4.5
https://sourceforge.net/projects/jregistrykey/
LGPL (Version 2.1, February 1999)

log4j-1.2.14.jar

Version 1.2.14
http://logging.apache.org/log4j/docs

The Apache Software License, Version 1.1
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myfaces-api-1.2.3.jar

Version 1.2.3

http://myfaces.apache.org/

Apache License Version 2.0, January 2004

myfaces-impl-1.2.3.jar

Version 1.2.3

http://myfaces.apache.org/

Apache License Version 2.0, January 2004

ojdbc14.jar

Version 10.2.0.1.0
http://www.oracle.com
Bought

quartz.jar

Version 1.6.0
http://www.opensymphony.com/quartz/
Apache License Version 2.0, January 2004

richfaces-api-3.3.1.GA.jar
Version 3.3.1.GA
http://www.jboss.org/richfaces
LGPL

richfaces-impl-3.3.1.GA.jar
Version 3.3.1.GA
http://www.jboss.org/richfaces
LGPL

richfaces-ui-3.3.1.GA.jar
Version 3.3.1.GA
http://www.jboss.org/richfaces
LGPL

serializer.jar

Version 2.7.0
http://xml.apache.org/xalan-j/

Apache License Version 2.0, January 2004

struts.jar

Version 1.2.4

http://struts.apache.org/

Apache License Version 2.0, January 2004

Stun4].jar

No versioning
https://stun4j.dev.java.net/

LGPL (Version 2.1, February 1999)

velocity-1.4.jar

Version 1.4

http://velocity.apache.org/

Apache License Version 2.0, January 2004

velocity-tools-1.1.jar

Version 1.1

http://velocity.apache.org/

Apache License Version 2.0, January 2004

WinRegistry-4.5.jar

Version 4.5
https://code.google.com/p/java-registry/
LGPL

xalan.jar

Version 2.7.0
http://xml.apache.org/xalan-j/

Apache License Version 2.0, January 2004
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xmlsec-1.4.5.jar

Version 1.4.5
http://santuario.apache.org/

Apache License Version 2.0, January 2004



A

acknowledged events
action types
active alarm/event
actuators, definition
Adcon system
adding
actions
areas in Explorer
extensions and crops to areas
manual events from Events viewer
multiple extensions and crops
objects to a List
RTU diagnostics to a tag
RTU diagnostics when adding RTU
tags to Data views
treatments from events viewer
advanced settings
search
settings tab
showing for extensions
alarms
colors of alarms
displaying in Explorer
events
locating source
showing
American measurements
area
adding extensions and crops
definition
new in Explorer
ASCII export
copy to clipboard
copy to csv
automatic
install crop extensions
settings values recalculation
autoscale
autostack
average_user role

B

band, Data view

base station, definition
button

(o)

calculation extensions
settings
changing
Data view options
dates for phenological phases
engineering units

password
security settings
sensor values
user options
checkbox, definition
choosing tags for a Trend viewer
Climate Manager 25,
climate settings
common settings of extensions and crops
condition, setting
configuring
extensions and crops
update configuration
context menu 16,
context sensitivity
creating
Data view panel
Data view panel from template
events in the viewer
List
nodes
crops
adding multiple
adding to areas
automatically installing disease models
configuring
default start date
definition 15,
hiding
settings
starting new season
tools menu
using templates

D

Data view panel
adding tags to Data views
creating from template
default options
definition
displaying data
drag and drop
example
exporting data
instrument view
making public
opening
saving a view
selecting options
setting thresholds
default options, all panels
defaults
crop start date
Data view options
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definitions
active (alarm or event)
actuators
area
base station
checkbox
context sensitivity
crops 15,
Data view panel
diagnostic extensions
disease models 15,
drop-down
Events viewer
Explorer
extension
extensions 10,
List
listbox
panel
radio button
remote station
root node
RTU
RTU diagnostics
sensor
server
services
tab
tag
text field
virtual sensor
deleting
objects from a List
diagnostics
RTU
disconnecting from the server
disease models
definition 15,
settings
displaying
data in a Data view panel
engineering units
node IDs
drop-down, definition
duration
session timeout
E
editing
account privileges
password
personal information
read/write permissions
user profile
e-mail address
engineering units
Event List
Events Viewer
choosing nodes
creating events
definition
event types
hiding event types
options

INDEX

removing areas
showing alarms
showing event types
Explorer
crops
definition
disease model
displaying alarms
extensions
panels
RTU
tags
tools menu
exporting
ASCII data from trend
selected trend data
extensions
adding multiple
adding to areas
automatic recalculation
common settings
configuring
crop stages
definition 10,
hiding
in Explorer
input tags
plausibility
showing alarms in Explorer
tab on settings dialog
tools menu
using templates

F

forcing
settings recalculation
full name
G
Graph view of data
H
hiding event types in events viewer

I

imperial measurements
importing
tag values
instrument view of Data view panel
intended use
irrigation
adding to events viewer
settings
K
Képpen-Geiger climate classification
L
language, selecting
List
adding items through search
adding objects
definition
deleting objects
opening
quick search
listbox, definition
locating the source of alarms
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M

magnifying glass

manual event, adding to viewer
menu bar

metric measurements
modularity of Adcon system

N

new features
node IDs, displaying
nodes
creating
renaming
selecting to display events
o
opening
Data view panel
List
options in an Events Viewer
overlap

P

panels
default options
definition
reopening last panels
tools menu
parameters
password, needed for WAP access
phenological phases
phone number
plant protection settings
plausibility extension
plot settings
public Data view

Q

quick search
quick search for List items

R

radio button, definition
receiver
remote station, definition
removing

areas from event viewer

Remote Transmission Unit
renaming nodes
reopening panels when logging in
root node, definition
RTU

definition

in areas

in Explorer

settings
RTU diagnostics 30, 58, 60,
S

safety instructions
saving

Data view as a panel
searching for items to add to a List
security

node

user options
selecting

ASCII data sets to export

INDEX

language
nodes to display events for
options for a Data view panel
sensor, definition
server
definition
disconnecting from
service logs, events
services
chemicals
definition
session timeout
duration
settings
actions
advanced settings
calculation extensions
conditions that trigger events
crop
Data view thresholds
default start date for crops
diagnostic extensions
disease models
events and actions
extensions
input tags for extensions
inputs settings
node permissions
permissions
plots
RTUs and tags
tag thresholds
tools menu 29,
treatments
showing
advanced settings for extensions
alarms in Events Viewer
crops
extensions
node IDs
showing hidden event types in events viewer
starting
new season of crop
switching from graphical to tabular view

T
tab, definition
tabular view of data
tags
adding to data views
definition
in Explorer
setting in extensions
setting thresholds
settings
templates
creating Data view panel
extension, crop
terminology and abbreviations
text field, definition
thresholds
Data view
tag
tool bar
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tools menu
chemicals
crops
engineering units
explorer
extensions
panels
security
settings
using
transmitter
treatments
adding to events viewer
recommending
settings
types of events for Events Viewer

u

updating the system configuration
user 4 14 4 4
options, changing
user role 9, 20,
using
imperial measurements
metric measurements
template for Data view panels
tools menu
v
viewing
data
data in Graph view
data in Table view
Data views
events

switching from graphical to tabular view

virtual instruments
view
virtual sensor, definition
visibility of crops
w
WAP
password needed
what’s new

INDEX
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